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ΚΑΤΑΣΚΕΥΗ ΗΛΕΚΤΡΟΝΙΚΟΥ ΚΥΚΛΩΜΑΤΟΣ 

ΣΕ ΔΙΑΤΡΗΤΗ ΠΛΑΚΕΤΑ
1.1
ΤΟ ΗΛΕΚΤΡΙΚΟ ΚΟΛΛΗΤΗΡΙ 
Για να κολλήσουμε τα ηλεκτρονικά εξαρτήματα πάνω στην πλακέτα ή στο σασί χρειαζόμαστε α)ένα ηλεκτρικό κολλητήρι και β) κόλληση.

α. Απλό ηλεκτρικό κολλητήρι
Το απλό ηλεκτρικό κολλητήρι αποτελείται από τα εξής μέρη: Μια αντίσταση, το μεταλλικό κάλυμμα της αντίστασης, μια χάλκινη προέκταση (μύτη), μια ξύλινη ή πλαστική λαβή και το καλώδιο τροφοδότησης με το φις (ρευματολήπτης) (σχ.1.1).
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Σχήμα 1.1 Ηλεκτρικό κολλητήρι
Όταν κυκλοφορεί ρεύμα από την αντίσταση, αυτή θερμαίνεται και στη συνέχεια θερμαίνεται και η μύτη, την οποία περιβάλλει η αντίσταση στο ένα άκρο της, χωρίς να έρχεται σε ηλεκτρική επαφή με αυτή. Η θερμή πλέον μύτη εφάπτεται στα προς συγκόλληση σημεία και τα θερμαίνει. 

Η θερμαντική του ικανότητα εκφράζεται με την ισχύ αυτού σε Watt. Όταν οι επιφάνειες που πρόκειται να συγκολληθούν είναι μεγάλες και τα μέταλλα χοντρά, απαιτείται συνήθως κολλητήρι ισχύος 200-250 W. 

Για συγκολλήσεις λεπτών αγωγών και εξαρτημάτων, κολλητήρι ισχύος 80-100 W είναι κατάλληλο. Για συγκόλληση αγωγών και λεπτών εξαρτημάτων χρησιμοποιείται κολλητήρι ισχύος περίπου 40W.
β. Τρόπος κόλλησης

Η κόλληση είναι κράμα κασσίτερου και μολυβιού. Ανάλογα με το κύκλωμα που έχουμε να μοντάρουμε, τοποθετούμε πρώτα τα ευπαθή εξαρτήματα (τρανζίστορ, ολοκληρωμένα, διόδους) και έπειτα τα λιγότερο ευαίσθητα.

Ο τρόπος για μια καλή κόλληση είναι ο εξής (σχ. 1.2): Κρατάμε το κολλητήρι με το δεξί μας χέρι και με το αριστερό την κόλληση. Πλησιάζουμε το κολλητήρι από τη δεξιά πλευρά του προς κόλληση ακροδέκτη ώστε η μύτη του να ακουμπάει τον ακροδέκτη και το σημείο της λωρίδας του χαλκού που πρέπει αυτό να κολληθεί. 
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Σχήμα 1.2. Τρόπος κόλλησης
Ταυτόχρονα το αριστερό μας χέρι φέρνει την κόλληση κοντά στη μύτη του κολλητηριού κατά τρόπο ώστε να ακουμπάει στη μύτη του κολλητηριού, στον ακροδέκτη και στην τυπωμένη λωρίδα που ακουμπάει ο ακροδέκτης. Κρατάμε έτσι για λίγα δευτερόλεπτα το κολλητήρι και την κόλληση και έπειτα απομακρύνουμε το πρώτο ενώ φυσάμε για να κρυώσει η δεύτερη. Μετά το κόλλημα, στο σημείο που κολλήσαμε και συγκεκριμένα η ποσότητα της κόλλησης πρέπει να είναι χυτή (στιλπνή) και σε ποσότητα τόση όση απαιτείται για να καλυφθεί ο χώρος γύρω από τον ακροδέκτη. Ανώμαλη επιφάνεια κόλλησης δείχνει ότι η κόλληση είναι «ψυχρή» και η πιθανότητα «επιπλοκών» στη λειτουργία είναι μεγάλη. Επειδή η κόλληση περιέχει και την ειδική αλοιφή «σολντερίνη» για γρήγορο κόλλημα είναι απαραίτητο από σε καιρό να καθαρίζουμε τη μύτη του κολλητηριού από αυτήν. Συγκεκριμένα εμφανίζονται κάτι σαν «μαύρα κομμάτια» στα περιθώρια της μύτης. Με μια μικρή λίμα ή με τη μύτη ενός κατσαβιδιού ξύνουμε τα μέρη που έχει αυτή επικαθήσει.
1.2
ΠΕΡΙΓΡΑΦΗ ΒΗΜΑ ΠΡΟΣ ΒΗΜΑ ΚΑΤΑΣΚΕΥΗΣ ΗΛΕΚΤΡΟΝΙΚΟΥ ΚΥΚΛΩΜΑΤΟΣ ΣΕ ΔΙΑΤΡΗΤΗ ΠΛΑΚΕΤΑ

Το κύκλωμα που θα κατασκευάσουμε είναι ένας ενισχυτής του οποίου το ηλεκτρονικό διάγραμμα φαίνεται στο ακόλουθο σχήμα 1.
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Σχήμα 1. Ηλεκτρονικό Διάγραμμα Ενισχυτή

Η λίστα των υλικών του ενισχυτή είναι:
	Ποσότητα
	Περιγραφή υλικού


	1
	22ΚΩ λογαριθμικό ποτενσιόμετρο

	1
	1.5Ω αντίσταση, 5% ανοχής

	1
	10μF, 25WV ηλεκτρολυτικός πυκνωτής

	2
	330μF, 25WV ηλεκτρολυτικός πυκνωτής

	1
	100nF κεραμικός πυκνωτής 100V

	1
	LM386 γραμμικό ΙC

	1
	8 pin DIL βάση στήριξης (προαιρετική


Βήμα 1
Συλλέγουμε όλα τα εξαρτήματα και τα τοποθετούμε στον πάγκο (εικόνα 1). Ένα μικρό τρυπάνι ή ένα κοφτάκι χρησιμοποιείται κατάλληλα για να κόψει τις μεταλλικές λωρίδες.
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Εικόνα 1

Βήμα 2

Ένα κατάλληλο διαστάσεων κομμάτι διάτρητης πλακέτας (εικόνα 2) χρησιμοποιείται. Πρέπει να είναι αρκετά μεγάλο ώστε να τοποθετηθούν σωστά όλα τα εξαρτήματα του κυκλώματος. Τα εξαρτήματα έχουν συγκεκριμένες διαστάσεις ενώ η διάτρητη πλακέτα έχει 9 τρύπες εύρος και 25 τρύπες μήκος δηλαδή περίπου 2.5cm x 6.5cm. Καθεμιά από τις μεταλλικές λωρίδες είναι γνωστή ως ένα «track». Μια λωρίδα αντιστοιχεί σε μια γραμμή του ηλεκτρονικού διαγράμματος. Αν σε μια λωρίδα έχει διακοπεί η συνέχειά της  τότε έχουμε δύο μη συνδεδεμένες γραμμές στην ίδια οριζόντια λωρίδα. Πρέπει να σημειωθεί ότι δεν υπάρχει συνέχεια μεταξύ γειτονικών λωρίδων. 
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Εικόνα 2
Αν συμβεί να κοπεί μια λωρίδα, κατά λάθος, τότε πρέπει να δημιουργηθεί μια γέφυρα μεταξύ των δύο κομματιών αλλιώς δε θα λειτουργεί το κύκλωμα.. Επομένως πρέπει προσεκτικά να κόβουμε τις λωρίδες και κατόπιν να εξετάζουμε προσεκτικά την πλακέτα μετά τα κοψίματα.

Βήμα 3

Ελέγχουμε ότι η διάτρητη πλακέτα είναι αρκετά μεγάλη βάζοντας όλα τα εξαρτήματα στις τρύπες με οποιαδήποτε διάταξη. Αφήνουμε τουλάχιστον δύο τρύπες διάστημα μεταξύ των εξαρτημάτων. Αυτό θα μας επιτρέψει να δημιουργήσουμε γραμμές και διακοπές στις λωρίδες..
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Εικόνα 3
Βήμα 4

Είμαστε έτοιμοι τώρα να ξεκινήσουμε. Φανταστείτε ότι οι γραμμές του ηλεκτρονικού διαγράμματος είναι τα καλώδια και τα σύμβολα είναι τα εξαρτήματα. Από τα φυλλάδια των κατασκευαστών παίρνουμε τις αναγκαίες πληροφορίες ώστε να δούμε τις αντιστοιχίες μεταξύ των ακροδεκτών των εξαρτημάτων και του ηλεκτρονικού διαγράμματος.. 

[image: image9.jpg]ceecereen
terecrrer
srerecerry
ceeeccere
eerercrce
eerecrcrcr
eeecrercr
cerreerce
een e e oo
e et
e e
e e o
eeecerccr
crecececcr
erecececr
cerecceer
eerccrccr
ccerrcces
reececere
crececcce
ceececccr
cccrceced




Εικόνα 4
Δείτε τη λίστα των υλικών ώστε να αναγνωρίσετε τα εξαρτήματα. Κοιτάξτε το ηλεκτρονικό διάγραμμα. Το τρίγωνο αντιπροσωπεύει το LM386. Επειδή χρησιμοποιούνται επτά (7) συνδέσεις μια καλή πρακτική είναι να τοποθετήσουμε το LM386 κάπου στο κέντρο της πλακέτας.
Βήμα 5

Γυρίστε τη διάτρητη πλακέτα από την άλλη πλευρά της. Όλα οι ακίδες του (pin) του IC θα πρέπει να φαίνονται από αυτή την πλευρά. Όλες οι κολλήσεις και τα κοψίματα στις μεταλλικές λωρίδες θα γίνονται σε αυτή την πλευρά. Στο σημείο αυτό θα πρέπει να γίνουν οι απαραίτητες κολλήσεις. Είναι πιο καλό και πιο εύκολο όταν έχουμε ΙC εξαρτήματα να χρησιμοποιούμε κατάλληλες βάσεις στήριξης (socket). Με τον τρόπο αυτό κάνουμε κολλήσεις .στη βάση και όχι στο εξάρτημα. Έτσι αν συμβεί κάποια βλάβη στο εξάρτημα απλώς το βγάζουμε από τη βάση και το αλλάζουμε ενώ σε διαφορετική περίπτωση πρέπει να ξεκολλάμε και να κολλάμε πάλι. 
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Εικόνα 5
Κολλάμε διαγώνια στις δύο πλευρές του IC (όπως φαίνεται στην εικόνα 5). Στο κέντρο του IC κόβουμε τις μεταλλικές λωρίδες στις 4 τρύπες ώστε τα pins 1 &8, 2&7, 3&6, 4&5 να μην βραχυκυκλωθούν. 

Βήμα 6
Γυρίζουμε τη διάτρητη πλακέτα από την πλευρά τοποθέτησης των εξαρτημάτων και χρησιμοποιούμε δύο κατάλληλες κλέμες διάτρητης πλακέτας για να συνδέσουμε την τάση τροφοδοσίας. Είναι καλό να χρησιμοποιείτε η πρώτη μεταλλική λωρίδα για το (+) της τροφοδοσίας και την τελευταία για το (-).

[image: image11.jpg]



Εικόνα 6
Βήμα 7
Τώρα πρέπει να ξεκινήσει η καλωδίωση. Το pin 4 είναι η γείωση. Έτσι ένα μικρό καλώδιο-γέφυρα (γνωστό και ως jumper) πρέπει να χρησιμοποιηθεί για να συνδέσει τη μεταλλική λωρίδα που βρίσκεται το pin4 με αυτήν της γείωσης. Είναι σωστό να χρησιμοποιούμε ένα jumper μαύρου χρώματος για τις γειώσεις και κόκκινου χρώματος για τη σύνδεση με το (+) της τροφοδοσίας.
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Εικόνα 7
Βήμα 8

Στη συνέχεια κολλάμε τις δύο άκρες του καλωδίου. Όταν τελειώσει η εργασία της κόλλησης κόβουμε τα άκρα του καλωδίου κοντά στην πλακέτα (αυτή τη διαδικασία ακολουθούμε όπου χρειαστεί να χρησιμοποιήσουμε jumper).Το κόκκινο jumper συνδέει το pin 6 του IC με το (+) της τροφοδοσίας. Στην εικόνα 8 βλέπουμε πως έχουν γίνει οι κολλήσεις.
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Εικόνα 8
Βήμα 9

Τα εξαρτήματα μπορούν να τοποθετηθούν με οποιαδήποτε σειρά. Συνήθως προτιμάται να χρησιμοποιούμε τα μεγαλύτερα και σε μέγεθος εξαρτήματα της λίστας υλικών έτσι ώστε να πάντα να είμαστε ενήμεροι για το χώρο που παραμένει διαθέσιμος στην πλακέτα. Μια τεχνική είναι να κολλάμε πρώτα τα παθητικά εξαρτήματα όπως αντιστάσεις, πυκνωτές και πηνία , στη συνέχεια τα ενεργά εξαρτήματα όπως δίοδοι, τρανζίστορ κλπ. Τα ICs προστίθενται τελευταία για το λόγο ότι οι επαναλαμβανόμενες κολλήσεις υπερθερμαίνουν την πλακέτα και έτσι μπορούν να καταστρέψουν τα ευαίσθητα εξαρτήματα.
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Εικόνα 9
Τοποθετούμε τον πυκνωτή εξόδου 330μF. Από το ηλεκτρονικό διάγραμμα παρατηρούμε ότι το (+) χρειάζεται να συνδεθεί με το pin5 του IC. Τοποθετούμε το εξάρτημα μερικές τρύπες πιο μακριά στην ίδια μεταλλική λωρίδα με το pin 5 και στην ίδια κατεύθυνση (εικόνα 9).

Βήμα 10

Όπως φαίνεται και στην εικόνα 11 πριν κολλήσουμε τον πυκνωτή πρέπει να κάψουμε τη μεταλλική λωρίδα στο μέσο του πυκνωτή. Αν ξεχάσουμε να το κάνουμε αυτό τότε θα έχουμε δημιουργήσει βραχυκύκλωμα. Τα εξαρτήματα μπορούν να τοποθετούνται στην ίδια γραμμή, διαγώνια κλπ., γενικά δεν υπάρχουν κανόνες. Εντούτοις αν τα άκρα των εξαρτημάτων βρίσκονται στην ίδια μεταλλική λωρίδα, τότε η λωρίδα πρέπει να κόβεται, διαφορετικά το εξάρτημα είναι βραχυκυκλωμένο. Η έξοδος από τον ενισχυτή είναι στην αρνητική πλευρά του πυκνωτή. Μια κατάλληλη κλέμα μπορεί να χρησιμοποιηθεί για να κάνει πιο εύκολη τη σύνδεση με ένα μεγάφωνο.
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Εικόνα 10
Βήμα 11

Καθώς ο πυκνωτής εξόδου έχει κολληθεί, συνδέουμε την αντίσταση 1R5 και τον 100nF πυκνωτή. Κοιτάζοντας το ηλεκτρονικό διάγραμμα, το ένα άκρο της αντίστασης συνδέεται με το pin5 , το ένα άκρο του πυκνωτή οδηγείται στη γείωση και τα ελεύθερα άκρα των δύο εξαρτημάτων που απομένουν συνδέονται μαζί. 
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Εικόνα 11
Βήμα 12

Στην εικόνα 12 φαίνονται οι κολλήσεις που έχουν γίνει στην αντίσταση 1R5 και στον 100nF πυκνωτή. Καθώς δεν απαιτούνται άλλες συνδέσεις στην ένωση της αντίστασης και του πυκνωτή η μεταλλική λωρίδα διακόπτεται ώστε η άλλη πλευρά να είναι ελεύθερη να χρησιμοποιηθεί. 
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Εικόνα 12

Βήμα 13

Κοιτάζοντας το ηλεκτρονικό διάγραμμα, η έξοδος του ενισχυτή είναι σχεδόν έτοιμη εκτός από έναν 10μF ηλεκτρολυτικό πυκνωτή που συνδέεται στα pins 1 & 8.του IC. Σημειώνουμε την πολικότητα, ώστε το θετικό άκρο να συνδέεται με το pin 1. Έτσι ο πυκνωτής τοποθετείται σε μια διπλανή τρύπα από το pin1 LM386.
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Εικόνα 13
Καθώς το pin 8 συνδέεται με το αρνητικό άκρο του πυκνωτή, χρησιμοποιείται ένα jumper ( μπλε χρώματος) για να ενώσει τα δύο άκρα όπως φαίνονται στην εικόνα 13.

Βήμα 14

Η πλευρά των κολλήσεων δείχνει τώρα όπως φαίνεται στην εικόνα 14..
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Εικόνα 14
Το μπλε jumper τοποθετείται όπως φαίνεται στην εικόνα 14. ο πυκνωτής κολλιέται και κόβεται για να μη δίνει βραχυκύκλωμα. Η δεύτερη μεταλλική λωρίδα, από την πάνω πλευρά, συνδέεται με το αρνητικό άκρο του πυκνωτή και με ένα μπλε jumper επιστρέφει στο pin 8 του LM386. Όπως και προηγουμένως η μεταλλική λωρίδα κόβεται επειδή δεν απαιτούνται άλλες συνδέσεις στο pin 1 & pin 8 και έτσι ελευθερώνεται ώστε να μπορεί να χρησιμοποιηθεί ξανά.
Βήμα 15

Στο σημείο αυτό καλό είναι να σημειώνονται με ένα μαρκαδόρο τα σημεία του ηλεκτρονικού διαγράμματος που έχουν συνδεθεί.
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Εικόνα 15
Κοιτάζοντας το ηλεκτρονικό διάγραμμα, βλέπουμε ότι η δεξιά πλευρά του ενισχυτή έχει κατασκευασθεί. Απομένει να συνδέσουμε τις εισόδου του LM386 και τον πυκνωτή. Μια σύνδεση από το pin 2 προς τη γείωση δημιουργείται.
Βήμα 16

Η σύνδεση (μπλε jumper) με τις απαραίτητες κολλήσεις πραγματοποιείται. Επειδή η πλακέτα είναι ανεστραμμένη η σύνδεση φαίνεται στη δεξιά πλευρά μεταξύ της πρώτης μεταλλικής λωρίδας (είναι η τελευταία λωρίδα) και της έκτης λωρίδας (μετράμε από κάτω προς τα πάνω).
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Εικόνα 16
Βήμα 17

Προστίθεται και ο τελευταίος 330μF ηλεκτρολυτικός πυκνωτής. Αυτός είναι ο πιο αριστερός πυκνωτής που φαίνεται στο ηλεκτρονικό διάγραμμα.
[image: image22.jpg]



Εικόνα 17
Ο πυκνωτής τοποθετείται έτσι ώστε το θετικό του άκρο να βρίσκεται στη μεταλλική λωρίδα του (+) της πηγής τροφοδοσίας και το αρνητικό άκρο στο στην ίδια λωρίδα με το pin 2 του LM386, το οποίο και γειώνεται. Το τελευταίο εξάρτημα είναι ο ρυθμιστής έντασης. Καθώς αυτός βρίσκεται εκτός της πλακέτας συνδέουμε ένα κομμάτι θωρακισμένο καλώδιο μεταξύ του pin 3 tτου LM386 και της γείωσης.
Βήμα 18

Η εργασία ολοκληρώθηκε. Απαιτείται ένας τελικός έλεγχος της πλακέτας. Χρειάζεται ιδιαίτερα να ελεγχθούν τα  τμήματα που έχουν γίνει κοψίματα στις μεταλλικές λωρίδες και τα σημεία όπου υπάρχουν εκτεταμένες κολλήσεις. Όλες οι κολλήσεις πρέπει να εμφανίζονται γυαλιστερές  όπως στην παρακάτω εικόνα..
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Εικόνα 18
Βήμα 19
Το τελικό κύκλωμα ενίσχυσης, με ένα μικρού μήκους θωρακισμένο καλώδιο (γκρι) που συνδέεται με το ρυθμιστή της έντασης που βρίσκεται εκτός της πλακέτας φαίνεται στην εικόνα 19.
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Εικόνα 19
1.3
ΕΡΓΑΣΤΗΡΙΑΚΕΣ ΑΣΚΗΣΕΙΣ ΚΑΤΑΣΚΕΥΗΣ

ΑΣΚΗΣΗ 1: ΡΥΘΜΙΖΟΜΕΝΟ ΤΡΟΦΟΔΟΤΙΚΟ
Το ηλεκτρονικό κύκλωμα του ρυθμιζόμενου τροφοδοτικού που θα κατασκευάσουμε φαίνεται στο ακόλουθο σχήμα
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Περιγραφή Λειτουργίας

Αρχικά επιλέγουμε έναν μετασχηματιστή(μ/τ) υποβιβασμού τάσης. Έτσι από τα 220V AC που μας παρέχει το δίκτυο με τον κατάλληλο μ/τ υποβιβάζουμε την τάση στα 24VAC. Μας ενδιαφέρει επιπλέον και η ισχύς του μ/τ που καθορίζει και το ρεύμα που είναι ικανός να μας διαθέσει.

Τα επόμενα τμήματα του τροφοδοτικού είναι η γέφυρα ανόρθωσης (RS404) και το φίλτρο εξομάλυνσης. Όσο πιο μεγάλος είναι ο πυκνωτής C1 που χρησιμοποιείται τόσο πιο επίπεδη θα είναι η καμπύλη εξομάλυνσης.

Στη συνέχεια έχουμε το τμήμα της σταθεροποίησης και ρύθμισης της τάσης. Στο συγκεκριμένο κύκλωμα χρησιμοποιούμε τον ολοκληρωμένο ρυθμιζόμενο σταθεροποιητή 3 ακροδεκτών, της σειράς LM317 (θετικός) που έχει την δυνατότητα να δίνει στην έξοδο του, τάσεις απαλλαγμένες από διακυμάνσεις, από 1,25V έως 37V και ρεύμα 1,5Α . Αυτές οι προδιαγραφές ισχύουν κάτω από συγκεκριμένες συνθήκες εργασίας και με κατάλληλη ψήκτρα. Ο σταθεροποιητής έχει  βέβαια ,προστασία από βραχυκύκλωμα της εξόδου, καθώς και θερμική προστασία. Η τάση εξόδου καθορίζεται από την σχέση των δυο αντιστάσεων R2 και R3 . H τάση στα άκρα της R2 είναι σταθερή στα 1,25V και το ρεύμα περίπου 100μΑ.
Η σχέση που μας δίνει την τάση εξόδου είναι Vout=1.25*[1+(R3/R2)]. Για να αποφύγουμε ανάστροφα ρεύματα, όταν κλείνουμε την τροφοδοσία τοποθετούμε τη δίοδο D1. Κοντά στους ακροδέκτες της εισόδου πρέπει να τοποθετήσουμε έναν πυκνωτή 1μF τανταλίου. Η αντίσταση R3 είναι ένα ποτενσιόμετρο, ώστε να έχουμε τη δυνατότητα , να ρυθμίζουμε την τάση εξόδου στην επιθυμητή τιμή.. Η μεγαλύτερη τάση που μπορούμε να εφαρμόσουμε στην είσοδο του LM317 είναι 40V.
Η λίστα των υλικών του ρυθμιζόμενου τροφοδοτικού είναι:
	α/α
	Περιγραφή υλικού
	Τύπος

	1
	Γέφυρα 
	RS404

	2
	Πυκνωτής C1
	4700μF (η/λ)

	3
	Πυκνωτής C2
	1μF (η/λ)

	4
	Αντίσταση R1
	330Ω

	5
	Αντίσταση R2
	220Ω

	6
	Αντίσταση R3 (ποτενσιόμετρο)
	4Κ7 

	7
	Δίοδος D1
	1N4003

	8
	Led L1
	LED 

	9
	Ρυθμιστής τάσης
	LM317


α.
Να πραγματοποιηθεί το παραπάνω κύκλωμα, και θέτοντας τάση εισόδου στην είσοδο της γέφυρα Vin = 24 VAC. να υπολογιστούν οι πειραματικές τιμές και να συμπληρωθεί ο ακόλουθος πίνακας (όπου η στήλη των θεωρητικών τιμών να συμπληρωθεί από τις τιμές που υπολογίστηκαν με το πρόγραμμα της προσομοίωσης) 
	α/α
	Τάση
	Πειραματική.
τιμή
	Θεωρητική.
τιμή

	1
	Στην έξοδο της γέφυρας
	
	

	2
	Στην είσοδο του ρυθμιστή τάσης
	
	

	3
	Στην έξοδο του ρυθμιστή τάσης
	
	

	4
	Στα άκρα της αντίστασης R2
	
	


β.
Ποιο είναι το εύρος τιμών της τάσης εξόδου.

ΑΣΚΗΣΗ 2: ΣΕΙΡΗΝΑ
Το ηλεκτρονικό κύκλωμα της σειρήνας που θα κατασκευάσουμε φαίνεται στο ακόλουθο σχήμα
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Περιγραφή Λειτουργίας

Η ηλεκτρονική σειρήνα θα κατασκευαστεί από διακριτά εξαρτήματα Όταν ο πρώτος διακόπτης (διακόπτης μεταγωγής) γίνει ΟΝ ο πυκνωτής 10μF είναι αφόρτιστος και τα δύο τρανζίστορ σε κατάσταση OFF. Όταν πατηθεί ο δεύτερος διακόπτης (διακόπτης πίεσης) ο πυκνωτής 10μF θα φορτιστεί μέσω της αντίστασης 22ΚΩ. Η τάση αυτή εφαρμόζεται στη βάση του τρανζίστορ BC108B το οποίο αργά θα βρεθεί σε κατάσταση ΟΝ. Όταν ο διακόπτης (button) αφεθεί ο πυκνωτής θα εκφορτιστεί μέσω των αντιστάσεων 100ΚΩ και 47ΚΩ και το BC108B θα οδηγηθεί αργά σε κατάσταση OFF. Η μεταβολή στην τάση μεταβάλλει τη συχνότητα της σειρήνας.
Ο κύκλος λειτουργίας της ταλάντωσης του κυκλώματος γίνεται σύμφωνα με τα ακόλουθα:

Καθώς το BC108B μεταβαίνει στην κατάσταση ΟΝ η τάση στο συλλέκτη μειώνεται και έτσι το τρανζίστορ 2Ν3702 γίνεται ΟΝ. Αυτό συμβαίνει πολύ γρήγορα (σε λιγότερο από 1ns) και ο πυκνωτής των 22nF θα φορτιστεί. Καθώς ο πυκνωτής αυτός συνδέεται μεταξύ του συλλέκτη του 2Ν3702 και της βάσης του BC108B γρήγορα η τάση στα άκρα του φτάνει την τάση τροφοδοσίας. Τότε το ρεύμα φόρτισης του πυκνωτή ελαττώνεται και η τάση συλλέκτη-εκπομπού του 2Ν3702 αυξάνεται (αφού το δυναμικό στο συλλέκτη μειώνεται.)

Η μεταβολή της τάσης περνάει μέσω του πυκνωτή 22nF στη βάση του BC108B προκαλώντας να έρθει και αυτό αργά σε κατάσταση κορεσμού. Καθώς αυτό συμβαίνει η τάση στο συλλέκτη του θα αυξάνεται και θα οδηγήσει το τρανζίστορ 2Ν3702 σε κατάσταση OFF. Ο πυκνωτής 22nF τότε θα εκφορτιστεί μέσω των αντιστάσεων 100ΚΩ, 22ΚΩ, του button (πατημένο), της τάσης τροφοδοσίας (μπαταρία 9V),του μεγαφώνου και της αντίστασης 56Ω. Ο χρόνος εκφόρτισης διαρκεί περίπου 5-6ms. Καθώς ο 22nF εκφορτίζεται, το BC108B τρανζίστορ θα βρεθεί πάλι σε κατάσταση ΟΝ και ο κύκλος θα επαναληφθεί.

Η διαφορά στην τάση στο συλλέκτη του BC108B (προκαλείται από τη φόρτιση του 10μF πυκνωτή) είναι η αιτία για την αλλαγή του τόνου (χροιά ή βαθμός έντασης ήχου) της σειρήνας. Καθώς ο 10μF πυκνωτής φορτίζεται ο τόνος θα μεγαλώνει και όταν αυτός εκφορτίζεται ο τόνος θα μειώνεται. Η διάρκεια του τόνου καθορίζεται από τον 10 μF πυκνωτή και την αντίσταση 22ΚΩ.
Η λίστα των υλικών της ηλεκτρονικής σειρήνας είναι:
	α/α
	Περιγραφή υλικού
	Τύπος

	1
	Τρανζίστορ ΡΝΡ 
	2N3702

	2
	Τρανζίστορ ΝΡΝ 
	BC108B

	3
	Πυκνωτής C1
	22n

	4
	Πυκνωτής C2
	10μ (η/λ)

	5
	Πυκνωτής C3
	2.2μ (η/λ)

	6
	Αντίσταση R1
	100Ω

	7
	Αντίσταση R2
	22Κ

	8
	Αντίσταση R3
	100Κ

	9
	Αντίσταση R4
	47Κ

	10
	Αντίσταση R5
	56Ω

	11
	Μεγάφωνο 8Ω
	

	12
	Διακόπτης μεταγωγής (switch) SW
	

	13
	Διακόπτης πίεσης (button) B
	


α.
Να πραγματοποιηθεί το παραπάνω κύκλωμα. 
β.
Η συμπεριφορά του κυκλώματος που κατασκευάσατε είναι σύμφωνη με την ανάλυση από το πρόγραμμα προσομοίωσης; Εξηγήστε τις διαφορές (αν υπάρχουν).
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2.1 
ΑΝΑΛΥΣΗ ΣΧΕΔΙΑΣΤΙΚΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ OrCAD Capture
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Για την εκκίνηση του πακέτου εξομοίωσης PSpice 9.1. (Student Version) είναι απαραίτητη η εκτέλεση του αρχείου Capture.exe.
Αυτό κατά κανόνα βρίσκεται στο φάκελο όπου είναι εγκατεστημένο το PSpice και συγκεκριμένα στο path:
C:\Program Files\PSpiceSV\Capture
Εναλλακτικά η εκκίνηση του προγράµµατος µμπορεί να γίνει από την taskbar (µπάρα εργασιών) ακολουθώντας διαδοχικά:
Start → Programs → orcad 9.1→ Capture CIS
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Πρέπει να σημειωθεί ότι αυτά που αναφέρονται άνωθεν ισχύουν για µία τυπική εγκατάσταση του προγράµµατος σε έναν Η/Υ. Το ακριβές path του εκτελέσιμου αρχείου Capture.exe µμπορεί να διαφέρει από υπολογιστή σε υπολογιστή ανάλογα τις εκάστοτε ρυθμίσεις κατά τη διαδικασία της εγκατάστασης.
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Κατόπιν της εκκίνησης του προγράµµατος (Capture.exe) εισερχόμαστε στο περιβάλλον αυτού. Για την ακρίβεια πρόκειται για ένα περιβάλλον εισαγωγής στο οποίο δεν είναι άµεσα δυνατή οποιαδήποτε ενέργεια – λειτουργία έχει σχέση µε την εξοµοίωση κυκλωµάτων. Σε αυτό το στάδιο είναι εφικτή µόνο η διεξαγωγή ρυθμίσεων που αφορούν το περιβάλλον εργασίας (ρυθμίσεις διαστάσεων της σελίδας σχεδίασης, χρωματικών επιλογών, γραμματοσειρών, επιλογών εστίασης, κτλ.), η εκκίνηση νέων ή η το άνοιγα παλαιών εργασιών (projects), η εκτύπωση (και οι ρυθμίσεις αυτής) φύλλων εργασιών κτλ. Αυτό αποδίδεται στην εικόνα που ακολουθεί:
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To Περιβάλλον του PSpice
Τα στοιχεία που χαρακτηρίζουν το εισαγωγικό περιβάλλον του προγράµµατος (PSpice 9.1 Student Version), όπως φαίνεται και από την παραπάνω εικόνα είναι
1. Eνα menu επιλογών

2. Kάποια button συντόµευσης (toolbar -γραµµή εργαλείων)

3. Tη γραµµή κατάστασης (status bar)

4. Kαι ένα επιπλέον πλαίσιο διαλόγου (Session Log), το οποίο και αποτελεί το τρέχον ηµερολόγιο του προγράµµατος.
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Από το menu επιλογών διεξάγονται όλες οι λειτουργίες και οι ρυθµίσεις του προγράµµατος είτε αυτές σχετίζονται είτε µε την διαχείριση και την προσπέλαση των αρχείων ενός project, είτε µε τον καθορισµό κάποιων χαρακτηριστικών του προγράµµατος, είτε τέλος, µε τις διάφορες διαδικασίες εξοµοίωσης και προβολής των αποτελεσµάτων. Αποτελεί δηλαδή τον κύριο και βασικό τρόπο χειρισµού του προγράµµατος από το χρήστη.
Το menu επιλογών χαρακτηρίζεται από κάποια πεδία τα οποία ουσιαστικά αποτελούν και την κεφαλίδα ή περιγραφή µια γενικότερης κατηγορίας εργασιών. Έτσι, οι διάφορες εργασίες-επιλογές είναι ταξινομημένες ανάλογα σε διάφορα (pull-up) υπο-menu - λίστες οι οποίες ενεργοποιούνται και εµφανίζονται κατόπιν την κατάλληλης επιλογής του αντίστοιχου πεδίου. Με άλλα λόγια, το κάθε πεδίο περιέχει µια σειρά υπο-επιλογών όπου κάθε µια αντιστοιχεί σε µια εξειδικευµένη εργασία
Μόνο ένα πεδίο µπορεί να ενεργοποιείται κάθε φορά, εµφανίζοντας µια λίστα επιλογών. Κάθε ενεργοποίηση ενός άλλου πεδίου, καταργεί αυτόµατα την πρώτη ενεργοποίηση.
Πρέπει ωστόσο να τονίσουµε τον ενεργό (active) χαρακτήρα του menu επιλογών. Αυτό µπορεί και µμεταβάλλεται ανάλογα µε την εκάστοτε εκτελούµενη διαδικασία, παρέχοντάς µας µόνο τις πιθανές επιλογές που σχετίζονται µε την παρούσα φάση επεξεργασίας και την εν’ λόγω εκτελούµενη εργασία. Με άλλα λόγια, το σύνολο των πεδίων και των επιλογών δεν είναι άµεσα διαθέσιµο ανά πάσα στιγµή στο χρήστη, αλλά µόνο το τµήµα των επιλογών που σχετίζεται µε την εκτελούµενη διαδικασία.

Συγκεκριµένα, κατά την εκκίνηση του προγράµµατος, παρατηρούµε την ύπαρξη των πεδίων: File, View, Edit, Options, Window και Help. Υπάρχουν και άλλα πεδία τα οποία δεν εµφανίζονται στην παρούσα φάση. Αυτά κυρίως περιέχουν τις επιλογές σχεδίασης και εξοµοίωσης οι οποίες αποκτούν ενδιαφέρον στη συνέχεια.  Τα κυριότερα από αυτά τα πεδία περιγράφονται παρακάτω:
.
Το πεδίο αυτό σχετίζεται µε µια σειρά υπο-επιλογών που αφορούν τη διαχείριση και την προσπέλαση των αρχείων εξοµοίωσης (∆ηµιουργία νέου αρχείου ή Project, Αποθήκευση, Άνοιγµα ήδη υπάρχοντος αρχείου ή Project κτλ). Με την υπο-επιλογή “Import” είναι δυνατή η εισαγωγή δεδοµένων για εξοµοίωση υπό µορφή σχηµατικού διαγράµµατος από συµβατά προγράµµατα. Απαραίτητη προϋπόθεση είναι η ύπαρξη κατάλληλου output file από το έτερο πρόγραµµα. Ως χαρακτηριστικό παράδειγµα αναφέρουµε το σχεδιαστικό πακέτο κυκλωµάτων ηλεκτρονικής Protel DXP της εταιρίας Altium. Τέλος, από το πεδίο αυτό είναι δυνατή η εκτύπωση όπως και η προεπιλογή των ρυθµίσεων του εκτυπωτή[image: image140.png]VIEW




Σε αυτό το πεδίο, γενικά, είναι δυνατή η επεξεργασία των διαφόρων τµηµάτων και προ-επιλεγµένων αντικειµένων του project (αντιγραφή, αποκοπή, επικόλληση, διαγραφή, περιστροφή κτλ.). Πρέπει επίσης να επισηµανθεί το γεγονός ότι µέσω της επιλογής PSpice Stimulus καθίσταται δυνατή η ρύθµιση των ιδιοτήτων των AC Stimulus πηγών κατά τη διαδικασία δηµιουργίας σχηµατικού διαγράµµατος στο αντίστοιχο παράθυρο [image: image141.png]


.
[image: image142.png]OPTIONS



Σε αυτό το πεδίο διεξάγονται οι ρυθµίσεις προβολής του περιβάλλοντος εργασίας. Κατά την εκκίνηση του προγράµµατος (και εφ’ όσον παραµένουµε στο εισαγωγικό περιβάλλον) είναι δυνατή µόνο η ρύθµιση εµφάνισης/απόκρυψης της γραµµής εργαλείων (toolbar). Από το πεδίο αυτό επίσης, παρέχονται επιλογές για την προβολή των διαφόρων αποτελεσµάτων εξοµοίωσης καθώς και των output files.
Το πεδίο αυτό αφορά τις διάφορες ρυθµίσεις και επιλογές που σχετίζονται είτε µε το περιβάλλον εργασίας, είτε µε κάποιο προ-επιλεγµένο αντικείµενο (διαστάσεις σελίδας, χρωµατικοί συνδυασµοί, γραµµατοσειρές κτλ.).[image: image143.png]




Το πεδίο αυτό περιέχει ρυθµίσεις που κατά κανόνα αφορούν την προβολή των διαφόρων παραθύρων του προγράµµατος. Μια ολοκληρωµένη διαδικασία εξοµοίωσης περιλαµβάνει πολλά στάδια εργασίας και επεξεργασίας αποτελεσµάτων. Ξεκινώντας από τη δηµιουργία του σχηµατικού διαγράµµατος και τη δηµιουργία αρχείου Bias Point, µέχρι την AC Transient και Sweep Ανάλυση. Για ευνόητους λόγους, τα διάφορα αυτά δεδοµένα απεικονίζονται σε διαφορετικά παράθυρα. Είναι ωστόσο δυνατό, για λόγους αµεσότητας και περιορισµού του χρόνου εργασίας, να επιθυµούµε την παράλληλη απεικόνιση των δεδοµένων αυτών. Έτσι λοιπόν, µέσω των επιλογών του πεδίου Window είναι δυνατή η ρύθµιση του τρόπου προβολής των διαφόρων αυτών παραθύρων του προγράµµατος.[image: image144.png]TooLs





Σε αυτό το πεδίο περιέχονται χρήσιµες λειτουργίες του συστήµατος. Με την επιλογή Bill of Materials δηµιουργείται αυτόµατα από το πρόγραµµα η λίστα των υλικών που απαιτούνται για την υλοποίηση της σχεδίασης. Με την επιλογή Create Netlist δηµιουργείται το κατάλληλο αρχείο διασύνδεσης των πληροφοριών του σχηµατικού διαγράµµατος (Capture) µε το συµβατό πακέτο σχεδίασης τυπωµένων κυκλωµάτων (OrCAD Layout) ή άλλα συµβατά πακέτα δηµιουργίας PCB, ενώ µε την επιλογή Design Rules Check ελέγχεται η ορθότητα της σχεδίασης.[image: image145.png]
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     Στο παρών πεδίο διεξάγονται οι ρυθµίσεις, η εκτέλεση και η προβολή των αποτελεσµάτων µιας εξοµοίωσης. Επίσης µε την επιλογή “Create Netlist” δηµιουργείται το κατάλληλο αρχείο διασύνδεσης των πληροφοριών του σχηµατικού διαγράµµατος (Capture) µε το συµβατό πακέτο σχεδίασης τυπωµένων κυκλωµάτων (OrCAD Layout) ενώ µε την επιλογή “View Netlist” είναι δυνατή η προβολή του αρχείου αυτού.
Το πεδίο αυτό εµφανίζεται µόνο στο σχηµατικό συντάκτη (Schematic Editor) και περιέχει τις επιλογές των στοιχείων για τη δηµιουργία του σχηµατικού διαγράµµατος. Μέσω αυτών καθίσταται δυνατή η τοποθέτηση των διαφόρων εξαρτηµάτων - στοιχείων και η καλωδίωσή (γαλβανική ένωσή) τους στο σχηµατικό διάγραµµα. Επιπλέον παρέχεται και η δυνατότητα δηµιουργίας γραφικών σχεδίων. (Τα γραφικά σχέδια χρησιµοποιούνται αποκλειστικά για τη βελτίωση της αισθητικής ενός σχηµατικού χωρίς να επηρεάζουν στο ελάχιστο τα ηλεκτρικά χαρακτηριστικά αυτού).[image: image147.png]BREAKOUT.OLB



  

Το πεδίο αυτό εµφανίζεται µόνο στα παράθυρα απεικόνισης των αποτελεσµάτων εξοµοίωσης(OrCAD PSpice A/D). Από εδώ είναι εφικτές οι βασικές επιλογές και λειτουργίες της εξοµοίωσης. Μέσω κατάλληλων ρυθµίσεων είναι δυνατή η επιλογή του τύπου της εξοµοίωσης (Bias Point, DC Sweep, AC Transient, AC Sweep), η επιλογή του χρονικού διαστήµατος καθώς και λειτουργίες ελέγχου όπως η εκτέλεση, η παύση και η διακοπή αυτής.[image: image148.png]





Το πεδίο αυτό εµφανίζεται µόνο στα παράθυρα απεικόνισης των αποτελεσµάτων εξοµοίωσης (OrCAD PSpice A/D). Από εδώ καθίσταται δυνατή η επιλογή των διαφόρων προς απεικόνιση µεγεθών - στοιχείων (τάσεις, ρεύµατα) όπως και η ενεργοποίηση cursor για την εύκολη και ακριβή προβολή των τιµών στα διάφορα σηµεία των κυµατοµορφών. Επίσης παρέχεται η δυνατότητα προβολής - µετασχηµατισµού των αποτελεσµάτων από το πεδίο του χρόνου στο πεδίο της συχνότητας (Fourier) και αντίστροφα.[image: image149.png]TRACE





Το πεδίο αυτό ενεργοποιείται µόνο στα παράθυρα απεικόνισης των αποτελεσµάτων εξοµοίωσης(OrCAD PSpice A/D). Μέσω των επιλογών του είναι δυνατή η κατ’ επιλογή γραφική απεικόνιση παραστάσεων µε επιλεγµένες εξαρτηµένες και ανεξάρτητες µεταβλητές (y=F(x)). Με άλλα λόγια είναι εφικτή η επιλογή των µεγεθών στους άξονες Χ και Y. Αυτό είναι ιδιαίτερα σηµαντικό για περιπτώσεις όπου απαιτείται η απεικόνιση του σήµατος εξόδου συναρτήσει του σήµατος εισόδου όπως συµβαίνει για τις περιπτώσεις ελέγχού της γραµµικότητας των  κυκλωµάτων. Επίσης, από την επιλογή αυτή είναι δυνατή η ρύθµιση της κλίµακας των αξόνων όπως και η προσθήκη ετικετών, γραµµών και γραφικών σχεδίων επί της γραφικής απεικόνισης των αποτελεσµάτων.[image: image150.png]PLOT





Το πεδίο αυτό αφορά τη χρήση βοήθειας σχετικά µε τη λειτουργία και τις πιθανές παραµέτρους του προγράµµατος. Η επιλογή αυτή αποτελεί ένα πολύ σηµαντικό στοιχείο, καθώς απευθύνεται σε όλους τους χρήστες (αρχάριους και µη) ανάλογα µε το είδος και τη φυσιολογία του προβλήµατος που συνάντησαν.[image: image151.png]




[image: image32.png]FPAMMH EPFAAEIQN
TOOLBAR




[image: image33.png]


 ∆ηµιουργία νέου αρχείου ή project
                                                          εναλλακτικά έχουµε: File → New → Project
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 Άνοιγµα ήδη υπάρχοντος αρχείου ή Project
                                                          εναλλακτικά έχουµε: File → Open → Project
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  Αποθήκευση του αρχείου ή project

                                                           εναλλακτικά έχουµε: File → Save
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  Εκτύπωση του φύλλου εργασίας
                                                           εναλλακτικά έχουµε: File → Print
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  Αποκοπή προεπιλεγµένου αντικειµένου
                                                           εναλλακτικά έχουµε: Edit → Cut
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  Αντιγραφή προεπιλεγµένου αντικειµένου
                                                           εναλλακτικά έχουµε: Edit → Copy
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  Επικόλληση αντικειµένου (του Clipboard)
                                                           εναλλακτικά έχουµε: Edit → Paste
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   Αναίρεση πληκτρολόγησης
                                                           εναλλακτικά έχουµε: Edit → Undo
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   Εστίαση µε µεγέθυνση της προβολής
                                                                  εναλλακτικά έχουµε: View → Zoom → In
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  Εστίαση µε σµίκρυνση της προβολής
                                                                 εναλλακτικά έχουµε: View → Zoom → Out
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  Εστίαση σε επιλεγµένη περιοχή προβολής
                                                                εναλλακτικά έχουµε: View → Zoom → Area
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  Εστίαση µε προβολή όλης της σελίδας
                                                                εναλλακτικά έχουµε: View → Zoom → All
[image: image45.png]


  Χρήση Βοήθειας σχετικά µε το πρόγραµµα
                                                                εναλλακτικά έχουµε: Help → Help Topics
Κατά την εργασία στο σχηµατικό συντάκτη (schematic Editor) είναι δυνατή η ενεργοποίηση προβολής και µιας δεύτερης γραµµής εργαλείων (Tool Palette) η οποία και απαρτίζεται από button – συντοµεύσεις των αγωγών και των εξαρτηµάτων σχεδίασης. Επίσης περιέχει και button µε τις επιλογές γραφικών σχεδίων. Η ενεργοποίηση – απενεργοποίηση αυτών των γραµµών εργαλείων είναι δυνατή µέσα από το menu επιλογών view όπως ειπώθηκε παραπάνω.
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Πρόκειται για το πεδίο – γραµµή που βρίσκεται στο κάτω µέρος της οθόνης και µας ενηµερώνει για τις τρέχουσες λειτουργίες και την κατάσταση του προγράµµατος. Η γραµµή κατάστασης µας ενηµερώνει ότι το πρόγραµµα είναι έτοιµο να δεχθεί τυχόν εντολές (Ready), όπως µας ενηµερώνει και για το τρέχον ενεργό παράθυρο του προγράµµατος (Session Log).
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Πρόκειται για ένα παράθυρο διαλόγου που ενεργοποιείται αυτόµατα κατά την εκκίνηση του προγράµµατος και κλείνει µόνο κατά την έξοδό µας από αυτό. Το Session Log ελέγχεται άµεσα µόνο από το σύστηµα και ουσιαστικά αποτελεί το τρέχον ηµερολόγιο του προγράµµατος όπου καταγράφονται οι διάφορες εργασίες (tasks) από τη στιγµή εκκίνησης του προγράµµατος.
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Προκειµένου να γίνει χρήση του προγράµµατος (και των δυνατοτήτων που αυτό παρέχει) για την εξοµοίωση κάποιου ηλεκτρικού ή ηλεκτρονικού κυκλώµατος απαιτείται η δηµιουργία  ενός νέου project στο πρόγραµµα. Ως project ουσιαστικά ορίζεται το σύνολο των αρχείων που φέρουν το ίδιο όνοµα (το όνοµα που έχει προσδώσει ο χρήστης στο project) και περιέχουν τις διάφορες σχεδιαστικές πληροφορίες του συγκεκριµένου ηλεκτρικού – ηλεκτρονικού κυκλώµατος ή ακόµα και τα αποτελέσµατα εξοµοίωσης αν αυτή έχει ήδη πραγµατοποιηθεί. ∆ηλαδή, τα αρχεία του σχηµατικού διαγράµµατος, τα αρχεία εξοµοίωσης κτλ. ενός κυκλώµατος απαρτίζουν ένα project.   Το πλήθος των αρχείων αυτών δεν είναι συγκεκριµένο αλλά µπορεί να µεταβάλλεται από project σε project ανάλογα µε το µέγεθος (αριθµό) και το είδος των αναλύσεων – εξοµοιώσεων που έχουν διεξαχθεί. Για την δηµιουργία ενός νέου project στο πρόγραµµα (PSpice 9.1 - Student Version) επιλέγουµε διαδοχικά:
File → New → Project
Στη συνέχεια εµφανίζεται ένα πλαίσιο διαλόγου
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Στο πεδίο name ορίζουμε το όνομα του project το οποίο σχετίζεται με το κύκλωμα που θα σχεδιάσουμε (παράδειγμα κυκλώματος πύλης NAND). Ιδιαίτερη προσοχή πρέπει να δοθεί στο θέμα της ονοματολογίας σε κάθε φάση του σχεδιασμού. Αμέσως μετά ορίζουμε τον τύπο του project. Στο πεδίο location ορίζουμε το πλήρες μονοπάτι του δίσκου στο οποίο θα τοποθετηθεί το project. Μπορούμε εναλλακτικά να χρησιμοποιήσουμε την επιλογή Browse.
Οι τύποι των project εξηγούνται παρακάτω αναλυτικά:
Η επιλογή αυτή αποσκοπεί σε χρήση του παραγόµενου σχηµατικού διαγράµµατος για εξοµοίωση αναλογικών ή υβριδικών (ψηφιακών και αναλογικών) ηλεκτρονικών διατάξεων. Για το σκοπό αυτό, εκτός από τα στοιχεία των σχηµατικών σχεδίων των βιβλιοθηκών του προγράµµατος (OrCAD PSpice), γίνονται διαθέσιµα και δεδοµένα που αφορούν την ηλεκτρική συµπεριφορά των εξαρτηµάτων.[image: image152.png]ANALOG OR MIXED AID






Με την επιλογή αυτή παρέχεται η δυνατότητα περαιτέρω αξιοποίησης του σχηµατικού διαγράµµατος για την δηµιουργία µακετών τυπωµένων κυκλωµάτων (PCB - Printed Circuit Board). Αυτό ωστόσο είναι εφικτό µόνο µε τη χρήση ενός κατάλληλου συµβατού προγράµµατος, του “OrCAD Layout”. Οι πληροφορίες διασύνδεσης των εξαρτηµάτων µεταφέρονται από το σχηµατικό διάγραµµα (Capture) στο πρόγραµµα “OrCAD Layout” µε τη βοήθεια ενός ειδικού αρχείου (netlist), όπου σε συνδυασµό µε τα “footprints” των διαφόρων εξαρτηµάτων χρησιµοποιούνται για να αποδώσουν τη µακέτα του τυπωµένου κυκλώµατος (PCB).[image: image153.png]PC BOARD WIZARD





Με την επιλογή αυτή παρέχεται η δυνατότητα σχεδίασης και υλοποίησης  διατάξεων που περιέχουν προγραµµατιζόµενες λογικές διατάξεις (CPLD, FPGA). Αυτό όµως, προϋποθέτει και την συµπληρωµατική χρήση ενός κατάλληλου συµβατού προγράµµατος, του “OrCAD Express”.[image: image154.png]PROGRAMMABLE LOGIC
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Με την ενεργοποίηση της επιλογής αυτής καθίσταται δυνατή η δηµιουργία µόνο σχηµατικών διαγραµµάτων των κυκλωµάτων χωρίς καµία µετέπειτα δυνατότητα επεξεργασίας. Αυτό συµβαίνει γιατί έτσι γίνονται διαθέσιµα (φορτώνονται) στο πρόγραµµα µόνο τα δεδοµένα των βιβλιοθηκών που σχετίζονται µε τα σχηµατικά σύµβολα των στοιχείων και όχι αυτά που περιέχουν την ηλεκτρική συµπεριφορά των χρησιµοποιούµενων εξαρτηµάτων.[image: image155.png]SCHEMATIC





Όταν ολοκληρώσουμε, περνάμε στο επόμενο παράθυρο στο οποίο επιλέγουμε τις βιβλιοθήκες ηλεκτρονικών στοιχείων που θα συμπεριληφθούν στο σχεδιασμό μας.
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Στο αριστερό πεδίο βρίσκονται κατηγοριοποιημένα σε βιβλιοθήκες όλα τα διαθέσιμα ηλεκτρονικά στοιχειά. Και δεξιά εμφανίζονται οι βιβλιοθήκες που θα χρησιμοποιηθούν στο project. Συνιστούμε να συμπεριλαμβάνεται όλες τις βιβλιοθήκες σε κάθε project για την αποφύγει λαθών, αλλά μπορούν να προστεθούν και κατά την διάρκεια του. Επιλέγουμε τις βιβλιοθήκες και τις προσθέτουμε ή τις αφαιρούμε στον σχεδιασμό μας χρησιμοποιώντας τα κουμπιά Add-Remove.Οι κυριότερες βιβλιοθήκες που θα χρησιμοποιηθούν στην αναλογική σχεδίαση είναι οι ακόλουθες:
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περιέχει ιδανικά στοιχειά όπως αντιστάσεις, πυκνωτές, πηνία.

[image: image157.png]DESIGN RESOURCES.



περιέχει τα βασικά ηλεκτρονικά στοιχειά όπως διόδους και τρανζίστορ. 

[image: image158.png]



περιέχει διάφορες πηγές ρεύματος και τάσης

Αφού ορίσαμε τις βασικές παραμέτρους του project μπορούμε να προχωρήσουμε στον σχεδιασμό του κυκλώματος. Πρώτα όμως θα κάνουμε μια μικρή περιήγηση στο περιβάλλον εργασίας.
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Βασικό περιβάλλον εργασίας του project
Στο περιβάλλον εργασίας του project που δημιουργήσαμε η πρώτη παρατήρηση που κάνουμε είναι ο εμπλουτισμός της γραμμής των κύριων εντολών με την προσθήκη νέων εντολών. Κάτι ανάλογο παρατηρούμε και στα κουμπιά συντόμευσης , πολλά από τα οποία είναι πλέον ενεργοποιημένα.
Στο κέντρο της οθόνης έχουν δημιουργηθεί δυο νέα παράθυρα ,το παράθυρο του project manager (αριστερά) και το παράθυρο σχεδίασης του σχηματικού του κυκλώματος με το όνομα Schematic:page1.
Ο project manager έχει την γενική διαχείριση του project. Στην ουσία πρόκειται για μια ταξινόμηση των κυκλωμάτων , των υλικών , των βιβλιοθηκών  και των παραμέτρων της προσομοίωσης, που χρησιμοποιούνται στο project προκειμένου ο χρήστης να ανατρέχει στα δεδομένα σχεδιασμού του. Οι πληροφορίες αυτές είναι ταξινομημένες με μορφή καταλόγων.
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project manager
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Είναι ο κύριος κατάλογος του σχεδιασμού. Αποτελείται από δυο βασικά μέρη: τα αρχεία του σχεδιασμού (κάτω από τον κατάλογο με το όνομα του σχεδιασμού και κατάληξη .dsn) και τις βιβλιοθήκες (κάτω από τον κατάλογο Library). Ειδικότερα τα αρχεία σχεδιασμού αποθηκεύονται σε περισσότερους από έναν κατάλογο με ονόματα που δίνουμε εμείς όπως (schematic 1). Ο κάθε σχεδιασμός τοποθετείται σε μια σελίδα page την οποία μπορούμε να δούμε σε μορφή σχηματικού διαγράμματος. Ένας ειδικός κατάλογος είναι ο κατάλογος Design Cache ο οποίος περιέχει τα ηλεκτρονικά κυκλώματα ή κυκλωματικά στοιχειά που έχουμε χρησιμοποιήσει εώς την τρέχουσα χρονική στιγμή  στον σχεδιασμό μας.                 
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Σε αυτόν τον κατάλογο τοποθετούνται διάφορα αρχεία εξόδου όπως αναφορές λαθών, αναφορές υλικών, περιγραφές του κυκλώματος σε διάφορα formats.
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Σε αυτόν τον κατάλογο τοποθετούνται όλα τα αρχεία που είναι απαραίτητα  για την προσομοίωση του κυκλώματος με το εργαλείο προσομοίωσης PSPICE.  Ενσωματώνει διάφορους υποκαταλόγους που περιέχουν πρόσθετα αρχεία για την προσομοίωση (Include Files), βιβλιοθήκες μοντέλων για την προσομοίωση των ηλεκτρονικών στοιχείων της σχεδίασης (Model Libraries), διαμορφώσεις (προφίλ) του περιβάλλοντος προσομοίωσης (Simulation Profiles), καθώς και αρχεία με κυματομορφές των σημάτων  εισόδου του υπό προσομοίωση κυκλώματος (Stimulus Files).


Το δεύτερο βασικό παράθυρο του περιβάλλοντος εργασίας του project είναι το παράθυρο του σχηματικού. Αποτελείται από ένα πλέγμα πάνω στο οποίο τοποθετούμε τα ηλεκτρονικά στοιχειά του σχεδιασμού μας. Εάν τοποθετήσουμε το ποντίκι πάνω σε ένα σημείο του παραθύρου θα παρατηρήσουμε ότι στην κάτω δεξιά γωνία του περιβάλλοντος εργασίας εμφανίζονται οι συντεταγμένες του σημείου αυτού. Εάν μετακινήσουμε τον δείκτη του ποντικιού θα παρατηρήσουμε ότι οι τιμές αυτές ανανεώνονται ανάλογα με την θέση στην οποία βρίσκεται ο δείκτης.
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Στο δεξιό μέρος της οθόνης εμφανίζεται μια κάθετη γραμμή εργαλείων με τις  συντομεύσεις των πιο απαραίτητων λειτουργιών σχεδίασης τα οποία θα εξηγήσουμε παρακάτω.
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Η λειτουργία του προγράµµατος βασίζεται στη χρήση των διαφόρων διακριτών εξαρτηµάτων – Parts (αντιστάσεις, πυκνωτές, πηνία, δίοδοι, transistors, IC’s κτλ.) Τα εξαρτήµατα αυτά (Parts) είναι ταξινοµηµένα σε κατηγορίες - βιβλιοθήκες (Libraries) ανάλογα το χαρακτήρα και τη φυσιολογία τους. Έτσι λοιπόν για παράδειγµα, παθητικά στοιχεία όπως οι αντιστάσεις, οι πυκνωτές και τα πηνία υπάγονται σε µια γενικότερη βιβλιοθήκη την ANALOG.OLB. Ηµιαγωγά στοιχεία όπως δίοδοι (diodes), transistors, πύλες (gates) και ολοκληρωµένα κυκλώµατα (IC – Integrated Circuits) περιέχονται σε µια άλλη βιβλιοθήκη την EVAL.OLB. Γενικά ισχύει:[image: image162.png]AIAYAOL
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• ANALOG.OLB   περιέχει παθητικά στοιχεία (αντιστάσεις, πυκνωτές, πηνία κτλ)
• ANALOG_P.OLB  αποτελεί την παλαιότερη έκδοση της βιβλιοθήκης παθητικών
στοιχείων
• EVAL.OLB Περιέχει ηµιαγωγά στοιχεία (diodes, transistors, ICs κτλ.)
• SOURCE.OLB  Περιέχει στοιχεία τροφοδοσίας και διέγερσης (AC/DC πηγές τάσης/ρεύµατος, γεννήτριες παλµοσειρών, κτλ.)
• SOURCSTM.OLB Περιέχει στοιχεία τροφοδοσίας και διέγερσης µε δυνατότητα ενεργοποίησης σε διακριτό δεδοµένο χρονικό σηµείο (AC/DC πηγές τάσης/ρεύµατος, γεννήτριες παλµοσειρών, κτλ.)
• ABM.OLB Περιέχει ειδικές διατάξεις υπό µορφή block diagrams που εκτελούν συγκεκριµένες διαδικασίες (διατάξεις συναρτήσεων, πινάκων, φίλτρων κτλ.). Οι συναρτήσεις αυτές (block diagrams, συνήθως χρησιµοποιούνται για την απλούστευση και τη συντόµευση µεγάλων κυκλωµάτων εξοµοίωσης.
• SPECIAL.OLB Περιέχει διατάξεις ειδικών λειτουργιών.
• Design Cache.OLB Πρόκειται για µια ειδική βιβλιοθήκη που δηµιουργείται και ελέγχεται αυτόµατα από το πρόγραµµα και περιέχει όλα τα πρόσφατα χρησιµοποιούµενα εξαρτήµατα. Πρέπει να σηµειωθεί ότι η βιβλιοθήκη αυτή δεν περιέχει αυτόνοµα δικά της εξαρτήµατα, αλλά εξαρτήµατα άλλων βιβλιοθηκών. Λειτουργεί δηλαδή σαν ένα στοιχείο µνήµης. Ο σκοπός αυτής της βιβλιοθήκης είναι να διευκολύνει το χρήστη  στη σχεδίαση του σχηµατικού διαγράµµατος δεδοµένου ότι είναι σχεδόν περιορισµένος και επαναλαµβανόµενος ο αριθµός και το είδος των εξαρτηµάτων που χρησιµοποιεί ένας µέσος χρήστης.
Η τοποθέτηση των εξαρτηµάτων στο σχηµατικό διάγραµµα γίνεται από το menu και συγκεκριµένα από τις διαδοχικές επιλογές:
Place → Part    ή µε τη χρήση του           [image: image57.png]



Στο προκύπτον πλαίσιο διαλόγου επιλέγουµε την κατάλληλη βιβλιοθήκη (από τη λίστα “Libraries”) και στη συνέχεια το επιθυµητό εξάρτηµα (από τη λίστα “Part List”).  


Επιπλέον, είναι δυνατός ο περιορισµός των αναζητούντων πιθανών εξαρτηµάτων (στη λίστα part list), µε τον ορισµό - αναγραφή από το χρήστη του ονόµατος ενός εξαρτήµατος (ή µέρους αυτού) στο πεδίο “part” (για συγκεκριµένη/ες βιβλιοθήκες). Έτσι, µε την τοποθέτηση του συµβόλου “C” στο πεδίο “part” κατά την αναζήτηση του εξαρτήµατος του πυκνωτή (C ) και ενώ έχουµε επιλέξει την κατάλληλη βιβλιοθήκη (ANALOG.OLB), πετυχαίνουµε τον περιορισµό της λίστας των εξαρτηµάτων (της βιβλιοθήκης) σε αυτά που αρχίζουν από “C” (C, C_elect, C_var), απ’ όπου πλέον πολύ εύκολα επιλέγουµε το επιθυµητό (C ).
Για την περίπτωση όπου ένα εξάρτηµα αγνοείται όπως επίσης και η βιβλιοθήκη ταξινόµησης του, είναι δυνατό να προβούµε στον πιθανό εντοπισµό του µέσω της επιλογής “part search” στο πλαίσιο διαλόγου “place part”.
Πρέπει να υπογραµµιστεί το γεγονός ότι κάθε εξάρτηµα στο σχηµατικό συντάκτη χαρακτηρίζεται από ένα µοναδικό συµβολισµό (part reference) και ένα πεδίο τιµής. Ο µοναδικός αυτός συµβολισµός “part reference” χρησιµοποιείται για λόγους αναφοράς ενώ το περιεχόµενο του πεδίου τιµής σχετίζεται άµεσα µε την ηλεκτρική συµπεριφορά του εξαρτήµατος. Για τα παθητικά στοιχεία, στο πεδίο τιµής ορίζεται ένας αριθµός (η τιµή του εξαρτήµατος) ενώ για τα ηµιαγωγά στοιχεία αναγράφεται ο τύπος του εξαρτήµατος.
Η διασύνδεση – καλωδίωση µεταξύ των διαφόρων εξαρτηµάτων αποτελεί θεµελιώδη εργασία για το σχηµατισµό του σχηµατικού διαγράµµατος. Αυτή είναι εφικτή από το menu και συγκεκριµένα από τις διαδοχικές επιλογές:[image: image163.png]



Place → Wire   ή µε τη χρήση του      [image: image58.png]



Κατόπιν των επιλογών αυτών παρατηρούµε ότι ο δείκτης του mouse pointer µεταβάλλεται σε σταυρό. Τότε είναι δυνατό µέσω του mouse και του αριστερού πλήκτρου του (κάνοντας ένα κλικ) να ορίσουµε το σηµείο εκκίνησης του αγωγού, ενώ µε δεύτερο κλικ το σηµείο τερµατισµού του. Κατά τη διαδικασία αυτή, όταν ο mouse pointer έρχεται σε επαφή µε τους ακροδέκτες κάποιου εξαρτήµατος, δηµιουργείται µια κόκκινη κουκίδα επισηµαίνοντας γαλβανική σύνδεση.
Το Net Alias (alias = ψευδώνυµο) είναι ένα ειδικό ηλεκτρικό εργαλείο σχεδίασης που κατά κανόνα χρησιµοποιείται να προσδώσει ένα ψευδώνυµο σε έναν αγωγό ή σε µια ένωση στο κύκλωµα µε σκοπό τη διευκόλυνση του χρήστη. Ωστόσο, κάνοντας χρήση Net Alias µε το ίδιο όνοµα είναι εφικτό να υποδηλωθεί γαλβανική ένωση µεταξύ σηµείων στο σχηµατικό διάγραµµα (ή µεταξύ σχηµατικών διαγραµµάτων στο ίδιο schematic folder). Λειτουργούν δηλαδή, ως σηµεία κοινού δυναµικού (εφ’ όσον φέρουν το ίδιο όνοµα) όπως συµβαίνει µε τα “Off Page Connectors” και τα “Hierarchical Ports”, καθιστώντας τα έτσι πολύ χρήσιµα εργαλεία. Αυτό γίνεται ιδιαίτερα εµφανές στην περίπτωση των διαύλων επικοινωνίας (busses) όπου απαιτείται ο διαχωρισµός των αγωγών στα σηµεία εισόδου / εξόδου από το bus.[image: image164.png]




     Γενικότερα πρέπει να θυµόµαστε ότι εντός µιας σχηµατικής σελίδας είναι δυνατό να υφίσταται γαλβανική ένωση µεταξύ ενός Net Alias, ενός OffPage Connector και ενός Hierarchical Port, εφ’ όσον αυτά φέρουν το ίδιο όνοµα (name).

Η τοποθέτησή των εξαρτηµάτων αυτών είναι εφικτή από το menu, επιλέγοντας διαδοχικά:
Place → Net Alias  ή µε τη χρήση του    [image: image59.png]



Στη συνέχεια στο προκύπτον πλαίσιο διαλόγου προσδίδουµε την κατάλληλη ονοµασία (ψευδώνυµο). Κατά την τοποθέτηση του Net Alias στο σχηµατικό διάγραµµα πρέπει να επισηµάνουµε ότι αυτό χαρακτηρίζει τον αγωγό ή την ένωση που εφάπτεται στην κάτω δεξιά γωνία αυτού.

Η πολλαπλή διασύνδεση µεταξύ δυο ψηφιακών συνήθως εξαρτηµάτων (επεξεργαστές, στοιχεία µνήµης RAM/ ROM κτλ), µε αγωγούς που µεταφέρουν σηµατοδοσία του ιδίου τύπου – σκοπού (data bus, control bus κτλ.) µπορεί να υποδηλωθεί και µε την χρήση διαύλου (bus). Αυτό αποσκοπεί κυρίως στην απλούστευση και στην διευκόλυνση της αντίληψης ενός πολύπλοκου κυκλώµατος. Φυσικά, µπορεί να ακολουθηθεί και η κλασική µέθοδος της τοποθέτησης απλών (οµοιότυπων) αγωγών όµως κάτι τέτοιο δυσχεραίνει την κατανόηση του διαγράµµατος (πολλοί αγωγοί, µεγάλη πυκνότητα αγωγών) και µπορεί να οδηγήσει σε σύγχυση.[image: image165.png]




     Η εισαγωγή διαύλου (bus) στο σχηµατικό διάγραµµα γίνεται µε τρόπο παρόµοιο της εισαγωγής απλής γαλβανικής καλωδίωσης (wire) µε τη διαφορά ότι οι δίαυλοι δεν απολήγουν στους ακροδέκτες των διαφόρων εξαρτηµάτων. Για το σκοπό αυτό χρησιµοποιούνται τα ηλεκτρικά στοιχεία “Bus Entry” που αναλύονται παρακάτω. Έτσι, για την τοποθέτηση διαύλου (bus) έχουµε:
Place → Bus    ή µε τη χρήση του  [image: image60.png]



Σε πολλές περιπτώσεις σχηµατικών διαγραµµάτων παρατηρείται το φαινόµενο να τέµνονται αγωγοί (ή διαύλων - busses) µε διαφορετικές διευθύνσεις. Άλλοτε οι τεµνόµενες αυτές γραµµές των αγωγών οφείλουν να υποδηλώνουν γαλβανική ένωση (και βρίσκονται στο ίδιο δυναµικό) ενώ άλλοτε όχι.[image: image166.png]MHFEZ TPO®OAOZIAL
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Για την διάκριση των δυο άνωθεν περιπτώσεων, το πρόγραµµα (OrCAD PSpice 9.1 SV) υιοθετόντας τους διεθνείς συµβολισµούς κάνει χρήση των στοιχείων “junctions”. Αυτά δεν είναι τίποτα περισσότερο από απλές κουκίδες (τελείες) των οποίων η τοποθέτηση στα σηµεία τοµής των αγωγών των υποδηλώνει γαλβανική ένωση. Αντιθέτως, η απώλειά τους από τα σηµεία αυτά, υποδηλώνει την ύπαρξη εντελώς ανεξάρτητων γαλβανικά αγωγών.
Έτσι για παράδειγµα, στην πρώτη περίπτωση (α) του παρακάτω σχήµατος οι τεµνόµενοι αγωγοί είναι εντελώς ανεξάρτητοι µεταξύ τους ενώ στη δεύτερη περίπτωση οι αγωγοί βρίσκονται στο ίδιο δυναµικό (γαλβανική ένωση).
[image: image61.png]b)




Η σηµασία των στοιχείων “junctions” είναι πολύ µεγάλη, και η χρήση τους πρέπει να γίνεται µε ιδιαίτερη προσοχή καθώς µια ενδεχοµένως λάθος τοποθέτηση οδηγεί αναµφισβήτητα στην εξοµοίωση εντελώς διαφορετικού κυκλώµατος από το επιθυµητό.

Η τοποθέτηση των στοιχείων “junctions” στο σχηµατικό διάγραµµα γίνεται µέσω των διαδοχικών επιλογών:
Place → Junction   ή µε τη χρήση του  [image: image62.png]



Η από-τοποθέτηση ενός τέτοιου στοιχείου γίνεται µε την εκ νέου τοποθέτηση στοιχείου “junction” πάνω από το ήδη υπάρχον.
Η σχεδίαση ψηφιακών κυκλωµάτων µε τη χρήση διαύλων επικοινωνίας (Βus) απαιτεί την υιοθέτηση της χρήσης σηµείων Εισόδου / Εξόδου ∆ίαυλου Επικοινωνίας (Bus Entry) προς και από τους διαύλους. Τα στοιχεία αυτά είναι που απολήγουν στους ακροδέκτες των διαφόρων εξαρτηµάτων (και όχι οι ίδιοι οι δίαυλοι οι οποίοι αντιστοιχούν σε οµάδες αγωγών) µια και αντιστοιχούν σε µεµονωµένους αγωγούς. Η τοποθέτησή τους είναι εφικτή µέσω των επιλογών:[image: image167.png]TFEIQZEIZ GROUNDS





Place → Bus Entry   ή µε τη χρήση του  [image: image63.png]
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Παράδειγμα  Bus Entry
Οι πηγές τροφοδοσίας και σηµατοδοσίας αποτελούν µια ειδική κατηγορία εξαρτηµάτων. Βρίσκονται ταξινοµηµένες στην βιβλιοθήκη SOURCE.OLB ενώ η τοποθέτησή τους είναι εφικτή από το menu, επιλέγοντας διαδοχικά:[image: image168.png]




Place → Source   ή µε τη χρήση του  [image: image65.png]



Στη συνέχεια στο προκύπτον πλαίσιο διαλόγου επιλέγουµε την κατάλληλη βιβλιοθήκη (από τη λίστα Libraries) και στη συνέχεια το επιθυµητό εξάρτηµα πηγής (από τη λίστα Part List). Για ταχύτερη εύρεση των εξαρτηµάτων – πηγών µπορεί να γίνει χρήση του πεδίου part.
Επίσης, είναι δυνατή η τοποθέτηση των διαφόρων πηγών (sources) ως εξαρτήµατα από το menu, µέσω των επιλογών:
Place → Part    ή µε τη χρήση του  [image: image66.png]



Κάθε πηγή (source) στο σχηµατικό συντάκτη χαρακτηρίζεται από ένα µοναδικό συµβολισµό (part reference) και ένα πεδίο τιµής. Το part reference χρησιµοποιείται ως στοιχείο αναφοράς ενώ το πεδίο της τιµής σχετίζεται άµεσα µε την ηλεκτρική συµπεριφορά του στοιχείου.
Οι γειώσεις κατά κανόνα χρησιµοποιούνται ως σηµεία αναφοράς δυναµικού στα διάφορα κυκλώµατα και ως εκ τούτου αποτελούν µια ειδική κατηγορία ηλεκτρικών εργαλείων. Βρίσκονται ταξινοµηµένες στην βιβλιοθήκη SOURCE.OLB ενώ η τοποθέτησή τους είναι εφικτή από το menu, επιλέγοντας διαδοχικά:  [image: image169.png]



Place → Ground   ή µε τη χρήση του  [image: image67.png]



Στη συνέχεια στο προκύπτον πλαίσιο διαλόγου επιλέγουµε την κατάλληλη βιβλιοθήκη (από τη λίστα Libraries) και κατόπιν το επιθυµητό εξάρτηµα γείωσης (από τη λίστα Part List). Επίσης, είναι δυνατή η χρήση Για ταχύτερη εύρεση των εξαρτηµάτων – γειώσεων µπορεί να γίνει χρήση του πεδίου part.
Παρατηρούµε ότι υπάρχουν διάφορα εξαρτήµατα γειώσεων. Κύριο ενδιαφέρον εµφανίζει η γείωση µε το χαρακτηρισµό “0” η οποία χρησιµοποιείται για να υποδηλώσει µηδενικό δυναµικό στο σηµείο σύνδεσής της. ∆ιαφορετικά σύµβολα γειώσεων φέρουν (υποδηλώνουν) διαφορετική ηλεκτρική συµπεριφορά και η πιθανή εσφαλµένη τοποθέτησή τους θα αλλοιώσει τα µετέπειτα αποτελέσματα της εξοµοίωσης. Γενικά, συνίσταται να χρησιµοποιούµε τη γείωση µε την ένδειξη “0”.


[image: image68.png]



Ground
Για τη διευκόλυνση της σχεδίασης και την απλούστευση των σχηµατικών διαγραµµάτων, είναι δυνατή η διεξαγωγή ιεραρχικής σχεδίασης. Κατά τη µέθοδο αυτή έχουµε την τοποθέτηση διαφόρων “Hierarchical Blocks” στο πρωτεύων σχηµατικό διάγραµµα. Κάθε ένα “Hierarchical Block” αντιστοιχεί σε ένα ιδιαίτερο τµήµα του συνολικού κυκλώµατος και σχεδιάζεται σε ξεχωριστή σχηµατική σελίδα.[image: image170.png]




    Η τοποθέτηση των διαφόρων “Hierarchical Blocks” γίνεται µε τις παρακάτω διαδοχικές επιλογές:
Place → Hierarchical Block ή µε τη χρήση του  [image: image69.png]



Κάθε hierarchical block στο σχηµατικό συντάκτη χαρακτηρίζεται από ένα µοναδικό συµβολισµό (part reference) το οποίο χρησιµοποιείται για να του προσδώσει µια (µοναδική) ονοµασία. Η διασύνδεση των διαφόρων “Hierarchical Blocks” µε το πρωτεύων σχηµατικό διάγραµµα αλλά και µεταξύ τους απαιτεί τη χρήση κάποιων εξειδικευµένων στοιχείων – εξαρτηµάτων, τα “Hierarchical Ports” τα οποία εξετάζονται στη συνέχεια.
Τα εργαλεία αυτά είναι παρόµοια µε τους Off Page Connectors µε τη διαφορά ότι χρησιµοποιούνται για να παρέχουν συνδέσεις µεταξύ των διαφόρων επιπέδων σε µια ιεραρχική σχεδίαση (µέσα όµως στο ίδιο schematic folder). Αυτό γίνεται εφικτό[image: image171.png]KEIMENO TEXT



 τοποθετώντας δυο (ή περισσότερα) Hierarchical Ports µε το ίδιο όνοµα στα διάφορα επίπεδα (ένα σε κάθε επίπεδο).

Τα εξαρτήµατα αυτά βρίσκονται ταξινοµηµένα στην βιβλιοθήκη CAPSYM.OLB ενώ η τοποθέτησή τους είναι εφικτή από το menu, επιλέγοντας διαδοχικά:
Place → Hierarchical Port  ή µε τη χρήση του  [image: image70.png]



Στη συνέχεια στο προκύπτον πλαίσιο διαλόγου επιλέγουµε τον κατάλληλο τύπο εξαρτήµατος.
Οι Off Page Connectors χρησιµοποιούνται για να υποδηλώσουν την ύπαρξη του ίδιου δυναµικού µεταξύ δύο αποµακρυσµένων σηµείων που δεν φέρουν µεταξύ τους αγωγό σύνδεσης. Ουσιαστικά, αντιστοιχούν µε γαλβανική ένωση των δυο σηµείων. Έτσι, τοποθετώντας δυο τέτοια στοιχεία (Off Page Connectors) µε το ίδιο όνοµα (name) σε σηµεία Α και Β, το πρόγραµµα θέτει τα σηµεία αυτά στο ίδιο δυναµικό (Προσοχή στη διαφοροποίηση των χαρακτήρων σε Κεφαλαία - Μικρά). Αξίζει να σηµειωθεί ότι οι “Οff Page Connectors” δύναται να ενώνουν και σηµεία τα οποία βρίσκονται σε διαφορετικές σχηµατικές σελίδες-schematic pages (µέσα όµως στο ίδιο schematic folder).    [image: image172.png]TPAMMH IXEAIAZHE
LINE





Τα εξαρτήµατα αυτά βρίσκονται ταξινοµηµένα στην βιβλιοθήκη CAPSYM.OLB ενώ η τοποθέτησή τους είναι εφικτή από το menu, επιλέγοντας διαδοχικά:

Place → Off Page Connector ή µε τη χρήση του   [image: image71.png]



Στη συνέχεια στο προκύπτον πλαίσιο διαλόγου επιλέγουµε τον κατάλληλο τύπο εξαρτήµατος.
Ουσιαστικά πρόκειται για ένα πλαίσιο απλού κειµένου του οποίου το περιεχόµενο (Text) και το σηµείο τοποθέτησης επί της σελίδας σχεδίασης  ελέγχεται από το χρήστη. Συνήθως χρησιµοποιείται για την παράθεση επισηµάνσεων και σχόλιων. Η τοποθέτησή του γίνεται ακολουθώντας διαδοχικά:[image: image173.png]MAPAAAHAOTPAMMO
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Place → Text   ή µε τη χρήση του  [image: image72.png]



Στο παράθυρο διαλόγου (Place Text) που εµφανίζεται, ορίζουµε τα επιθυµητά σχόλια στο αντίστοιχο πεδίο και κατόπιν δίνοντας “ΟΚ” επιλέγουµε το επιθυµητό σηµείο τοποθέτησης.
Η γραµµή σχεδίασης (Line) είναι το βασικό στοιχείο σχεδίασης. Πρόκειται για ένα ευθύγραµµο τµήµα µεταξύ δύο σηµείων επιλογής στη σχηµατική σελίδα. Για την τοποθέτησή της επιλέγουµε διαδοχικά:[image: image174.png]




Place → Line    ή επιλέγοντας το  [image: image73.png]



Παρατηρούµε ότι ο δείκτης του mouse pointer µεταβάλλεται σε σταυρό (όπως συµβαίνει και κατά την τοποθέτηση αγωγών σύνδεσης) . Τώρα είναι δυνατό κάνοντας ένα κλικ να ορίσουµε το σηµείο εκκίνησης, ενώ µε δεύτερο κλικ το σηµείο τερµατισµού.
Πρέπει να σηµειωθεί ότι το πρόγραµµα είναι εφοδιασµένο µε µια σειρά γραµµών και γεωµετρικών σχεδίων αποσκοπώντας στη µέγιστη κάλυψη ενός µεγάλου φάσµατος αναγκών.[image: image175.png]




Η τοποθέτηση παραλληλόγραµµου στη σχηµατική σελίδα είναι εφικτή µέσω των επιλογών:
Place → Line    ή εναλλακτικά µε  [image: image74.png]



Η τοποθέτηση ελλειπτικού στη σχηµατική σελίδα είναι εφικτή µέσω των επιλογών:
Place → Ellipse    ή εναλλακτικά µε  [image: image75.png]



Η τοποθέτηση ημικυκλίου στη σχηµατική σελίδα είναι εφικτή µέσω των επιλογών:
Place → Arc    ή εναλλακτικά µε   [image: image76.png]



Στη συνέχεια µε πατηµένο το αριστερό πλήκτρο του mouse, ορίζουµε τις ακριβείς διαστάσεις αυτού.
[image: image77.png]



Είµαστε πλέον σε θέση να ξεκινήσουµε την σχεδίαση του κυκλώµατος. Φέρνουµε το παράθυρο του σχηµατικού στο προσκήνιο και παρατηρούµε ότι εµφανίζεται η µπάρα µε τα εργαλεία σχεδίασης στο δεξιό τµήµα της οθόνης. Εάν µετακινήσουµε το ποντίκι πάνω σε κάποιο από τα κουµπιά συντόµευσης της θα δούµε ότι εµφανίζεται ο

τίτλος της λειτουργίας που αντιστοιχεί σε αυτό. Όλες αυτές οι λειτουργίες βρίσκονται και στην γραµµή εντολών, κατηγορία Place. Ο χρήστης µπορεί να επιλέξει τον τρόπο εκτέλεσής τους.
Έστω ότι ο στόχος του σχεδιασµού µας είναι ένας Differential Amplifier. Θα ξεκινήσουµε να τοποθετούµε τα απαραίτητα ηλεκτρονικά στοιχεία για την δηµιουργία του κυκλώµατος (στην προκειµένη περίπτωση MOS τρανζίστορς). Θα τοποθετήσουµε αρχικά ένα nMOS τρανζίστορ. Για να τοποθετήσουµε ένα οποιοδήποτε ηλεκτρονικό στοιχείο στο σχηµατικό µας χρησιµοποιούµε το εικονίδιο place part που απεικονίζεται παρακατω:
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Στο πεδίο µε τίτλο Part εισάγουµε το όνοµα του στοιχείου που θέλουµε να τοποθετήσουµε στο σχηµατικό µας. Αυτό θα πρέπει υποχρεωτικά να ανήκει σε κάποια από τις βιβλιοθήκες που έχουµε προσθέσει στο Project. Οι βιβλιοθήκες αυτές βρίσκονται στο πεδίο µε τον τίτλο Libraries. Μπορούµε να επιλέξουµε προσωρινά οποιαδήποτε και οσεσδήποτε από αυτές τις βιβλιοθήκες. Ανάµεσα στα πεδία Parts και Libraries βρίσκεται ένα τρίτο που περιέχει αλφαβητικά όλα τα στοιχεία των επιλεγµένων βιβλιοθηκών. Εάν επιλέξουµε ένα οποιοδήποτε στοιχείο τότε δεξιά από το πεδίο Libraries εµφανίζεται το σύµβολο µε το οποίο θα αναπαρίσταται στο σχηµατικό µας.
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Μία άλλη δυνατότητα είναι η προσθήκη ή αφαίρεση κάποιας βιβλιοθήκης χρησιμοποιώντας τις επιλογές add-remove library. Σε περίπτωση που δεν θυµόµαστε το ακριβές όνοµα του στοιχείου που θέλουµε να εισάγουµε τότε µπορούµε να το ψάξουµε χρησιµοποιώντας την επιλογή Part Search η οποία φαίνεται παρακατω:
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Στο πεδίο Part name εισάγουµε το τµήµα του ονόµατος που ψάχνουµε ακολουθούµενο από χαρακτήρες εύρεσης όπως ο * (κάθε αριθµός οποιονδήποτε χαρακτήρων) και ο ? (ένας οποιοσδήποτε χαρακτήρας) των οποίων την χρήση γνωρίζουµε. Από τα στοιχεία που προκύπτουν στο πεδίο Libraries µπορούµε πλέον να εντοπίσουµε το ζητούµενο. Όταν ολοκληρωθεί η επιλογή του επιθυμητού  ηλεκτρονικού στοιχείου το τοποθετούµε στο σχηµατικό

[image: image81.png]M1

MbreakND,




Παρατηρούµε ότι στον δείκτη του ποντικιού έχει προσκολληθεί ένα αντίγραφο του στοιχείου που επιλέξαµε. Εάν πατήσουµε το δεξιό πλήκτρο του ποντικιού εµφανίζονται διάφορες επιλογές µε τις οποίες µπορούµε να αλλάξουµε την κατεύθυνση και τις ιδιότητες του στοιχείου. Για να το τοποθετήσουµε αρκεί να πατήσουµε µία φορά το αριστερό πλήκτρο του ποντικιού, σε κάποιο σηµείο του σχηµατικού. Αµέσως µετά θα παρατηρήσουµε ότι συνεχίζει να είναι προσκολληµένο ένα αντίγραφο στον δείκτη του ποντικιού το οποίο µε την ίδια διαδικασία µπορούµε να τοποθετήσουµε σε οποιοδήποτε άλλο σηµείο του σχηµατικού. Για να αναιρέσουµε αυτή η διαδικασία πατάµε το πλήκτρο Escape. Παρατηρούµε ότι πάνω στο σύµβολο του τρανζίστορ αναγράφονται ο τύπος του (MbreakΝD) και το όνοµα του στοιχείου στην σχεδίαση (Μ1). Το όνοµα αυτό πρέπει να είναι µοναδικό για κάθε ηλεκτρονικό στοιχείο της σχεδίασης ώστε αυτή να µπορεί αργότερα να προσοµοιωθεί. Το τρανζίστορ αναγνωρίζεται ως nMOS από το βέλος στην γραµµή του ακροδέκτη πόλωσης του υποστρώµατος το οποίο έχει φορά από το κανάλι προς τον ακροδέκτη. Οι ακροδέκτες του τρανζίστορ αναγνωρίζονται ως ασύνδετοι από τα µικρά τετράγωνα που υπάρχουν στις άκρες τους. Πάνω σε αυτά τα τετράγωνα θα πρέπει να ακουµπήσουµε αργότερα τις κατάλληλες γραµµές διασύνδεσης. Καθώς οι ακροδέκτες Source και Drain του τρανζίστορ είναι ισοδύναµοι µεταξύ τους, ως Source λαµβάνεται ο ακροδέκτης προς τον οποίο στρέφεται ο ακροδέκτης του υποστρώµατος (Substrate - Bulk), δηλ. ο αριστερός από τους δύο ακροδέκτες στο επάνω µέρος του συµβόλου. Με την ίδια διαδικασία επιλέγουµε και τοποθετούµε στο σχηµατικό τα υπόλοιπα εξαρτήματα. Επιπλέον, µε το πάτηµα του δεξιού πλήκτρου του ποντικιού επάνω στο επιλεγµένο στοιχείο µας παρέχονται πρόσθετες δυνατότητες µέσω του ενός παραθύρου επιλογών/ενεργειών.
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Οι σηµαντικότερες από αυτές τις επιλογές είναι ο οριζόντιος και κατακόρυφος καθρεπτισµός του στοιχείου (Mirror Horizontally/Vertically), η περιστροφή του (Rotate) και η καταχώρηση/αλλαγή των κυκλωµατικών παραµέτρων προσοµοίωσης του ηλεκτρονικού στοιχείου (Edit Properties …) στην οποία θα αναφερθούµε αργότερα.

Το τελευταίο βήµα στην σχεδίαση ενός κυκλώµατος είναι η διασύνδεση των ηλεκτρονικών στοιχείων που τοποθετήσαµε στο σχηµατικό. Για να πετύχουµε την διασύνδεση δύο στοιχείων θα πρέπει να εντοπίσουµε τα επιθυµητά σηµεία (ακροδέκτες) στα οποία πρέπει να διασυνδεθούν και να τραβήξουµε ένα καλώδιο (wire) από το ένα σηµείο στο άλλο. Όπως αναφέραµε οι ακροδέκτες επισηµαίνονται µε τα κόκκινα τετράγωνα επάνω στα σύµβολα των στοιχείων. Για να τραβήξουµε ένα καλώδιο επιλέγουµε την εντολή Place>Wire. Πηγαίνουµε τον δείκτη του ποντικιού στο σηµείο που θέλουµε να ξεκινήσει το καλώδιο και πατάµε το αριστερό πλήκτρο του ποντικιού. Όσο µετακινούµε το ποντίκι παρατηρούµε ότι διαγράφεται το καλώδιο. Εάν σε κάποιο σηµείο θέλουµε να ορίσουµε µία κορυφή και να αλλάξουµε κατεύθυνση στην καλωδίωση, πατάµε µία φορά το αριστερό πλήκτρο του ποντικιού. Για να σταµατήσουµε το καλώδιο στο άλλο άκρο του, όπου θέλουµε να κάνουµε και την δεύτερη σύνδεση πατάµε δύο φορές το πλήκτρο του ποντικιού οπότε τοποθετείται αυτόµατα ένωση (junction). Για να σταµατήσουµε την διαδικασία τοποθέτησης καλωδίων πατάµε Escape.

ΠΡΟΣΟΧΗ: ∆ύο καλώδια µπορούν να είναι φυσικά συνδεδεµένα µε µία από τις

ακόλουθες µεθόδους:
1. Εάν διασταυρώσουµε δύο καλώδια το ένα πάνω από το άλλο και τοποθετήσουµε µία ένωση (Place Junction) στο σηµείο που διασταυρώνονται.
2. Εάν από κάποιο σηµείο ενός καλωδίου ξεκινήσουµε ένα άλλο καλώδιο µία ένωση τοποθετείται αυτόµατα και τα δύο καλώδια ενώνονται.
3. Εάν δύο καλώδια δεν έχουν καµία επαφή αλλά το ίδιο όνοµα τότε θεωρείται ότι είναι συνδεδεµένα. Μετά την τοποθέτηση του κάθε καλωδίου µπορεί να επιβεβαιωθεί η ορθότητα των διασυνδέσεων ως εξής: επιλέγουµε το καλώδιο που τοποθετήσαµε και πατάµε το δεξιό πλήκτρο του ποντικιού. Από τις επιλογές ενεργοποιούµε την Select Entire Net. Με τον τρόπο αυτό θα µαρκαριστούν όλα τα καλώδια που είναι συνδεδεµένα µε το συγκεκριµένο καλώδιο.
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Αφού ολοκληρώσουµε την εισαγωγή των στοιχείων του κυκλώµατος θα πρέπει να ορίσουµε τις εισόδους και/ή τις εξόδους του. Αυτό το πετυχαίνουµε µε την χρήση Ιεραρχικών Θυρών (Hierarchical Ports). Εκτελούµε την εντολή Place>Hierarchical Port ή Place Port . Μπορούµε να επιλέξουµε οποιοδήποτε σχήµα θύρας επιθυµούµε αλλά εδώ θα χρησιµοποιούµε πάντα την θύρα µε το όνοµα PORTLEFT-L. Η τοποθέτησή της γίνεται όπως στην περίπτωση των ηλεκτρονικών στοιχείων οπότε µπορούµε να την στρέψουµε προς όποια κατεύθυνση θέλουµε.
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Αφού επιλέξουµε OK στο παράθυρο και πριν τοποθετήσουµε την θύρα στο σχηµατικό, πατώντας το δεξιό πλήκτρο του ποντικιού επιλέγουµε Edit Properties. Τότε ανοίγει το παράθυρο διαλόγου όπου εισάγουµε το όνοµα της θύρας και τον τύπο της (Είσοδος/Έξοδος – Input/Output). Με αυτόν τον τρόπο µπορούµε να ορίσουµε τις εισόδους – εξόδους του κυκλώµατος.
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Οι πόρτες στο συγκεκριμένο κύκλωμα θα μπορούσαν να τοποθετηθούν στα σημεία Α και Β όπως φαίνεται στο σχηματικό διάγραμμα του κυκλώματος και ακόμη στις εισόδους αντικαθιστώντας τις γεννήτριες που έχουν τοποθετηθεί ώστε να τροφοδοτείται το κύκλωμα από προηγούμενη βαθμίδα ή κύκλωμα. Αντίστοιχα οι έξοδοι τροφοδοτούν επόμενες βαθμίδες ή κυκλώματα.
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Με την ενεργοποίηση του παραθύρου ενεργειών/επιλογών δίδεται η δυνατότητα διαµόρφωσης/αλλαγής των παραµέτρων προσοµοίωσης των ηλεκτρονικών στοιχείων της σχεδίασης µε την επιλογή Edit Properties. Αρχικά επιλέγουµε την πηγή DC τροφοδοσίας V1 για την διαµόρφωση της τιµής της τάσης που θα παρέχει στο κύκλωµα.
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Στην ενότητα αυτή θα αναπτυχθεί η διαδικασία της προσοµοίωσης που έχει σαν στόχο την επιβεβαίωση του ορθού σχεδιασµού του κυκλώµατος και τον έλεγχο της σωστής λειτουργίας του σύµφωνα µε τις προδιαγραφές. Με την προσοµοίωση αποδεικνύεται ότι το κύκλωµα έχει σχεδιαστεί σωστά, εάν λειτουργεί µε τον αναµενόµενο τρόπο.
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Το περιβάλλον προσοµοίωσης που διαθέτει το OrCAD για την προσοµοίωση αναλογικών κυκλωµάτων και κυκλωµάτων µεικτού (αναλογικού/ψηφιακού) σήµατος ονοµάζεται PSPICE και βασίζεται στο εργαλείο προσοµοίωσης SPICE. Αρχικά θα πρέπει να αρχικοποιηθεί το περιβάλλον προσοµοίωσης ώστε να οριστούν οι παράµετροι της προσοµοίωσης και τα αρχεία εκείνα που περιέχουν την απαραίτητη για τον προσοµοιωτή πληροφορία σχετικά µε τις κυκλωµατικές παραµέτρους των κυκλωµατικών στοιχείων της σχεδίασης. Για να αρχικοποιήσουµε το PSPISE επιλέγουµε PSpice > New Simulation Profile οπότε εµφανίζεται το παράθυρο όπου δίδεται από το χρήστη το όνοµα κάτω από το οποίο θα αποθηκευθεί η πληροφορία που αφορά την τρέχουσα διαδικασία προσοµοίωσης.
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Στο επόμενο παράθυρο εμφανίζονται οι ιδιότητες της προσομοίωσης .  Η πρώτη επιλογή είναι ο καθορισµός του τύπου της ανάλυσης που θα επιτελέσει ο προσοµοιωτής (Time Domain - Transient, DC Sweep, AC Sweep/Noise, Bias Point). Αναλυτική περιγραφή των διαφόρων τύπων θα δοθεί στη συνέχεια. Στην παρούσα φάση επιλέγουµε τον τύπο ανάλυσης στο πεδίο του χρόνου (Time Domain - Transient) και στις επιλογές (Options) το πεδίο της γενικής µορφοποίησης (General Settings). Επιπρόσθετα προσδιορίζουµε τον κυκλωµατικό χρόνο της προσοµοίωσης (Run to Time) ίσο µε 100ns και το µέγιστο βήµα µε το οποίο θα κινείται ο προσοµοιωτής (Maximum Step Size) ίσο µε 0.01ns.
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Στη συνέχεια µετακινούµαστε στο πεδίο των βιβλιοθηκών (Libraries) για να προσδιοριστεί το αρχείο µε τις παραµέτρους των ηλεκτρονικών στοιχείων που θα

χρησιµοποιήσει ο προσοµοιωτής. Οι βιβλιοθήκες των παραµέτρων των ηλεκτρονικών στοιχείων που χρησιµοποιεί ο προσοµοιωτής δεν σχετίζονται µε τις βιβλιοθήκες των ηλεκτρονικών στοιχείων του σχηµατικού οι οποίες περιέχουν µόνο σύµβολα αυτών των στοιχείων. Με την κατάλληλη πλοήγηση (Browse) επισηµαίνεται το κατάλληλο αρχείο στο σκληρό δίσκο του συστήµατος και προστίθεται στα αρχεία βιβλιοθηκών της σχεδίασης µε χρήση της επιλογής Add to Design. Τα αρχεία βιβλιοθηκών µιας σχεδίασης µπορούν να είναι περισσότερα του ενός αλλά ενεργό είναι πάντα αυτό που βρίσκεται στην κορυφή της στοίβας. Η θέσεις των αρχείων αυτών στο δίσκο βρίσκεται στην διακριτική ευχέρεια του χρήστη. Στην συγκεκριµένη περίπτωση επιλέγουµε το αρχείο βιβλιοθήκης µε τις παραµέτρους των τρανζίστορ σε τεχνολογία 0.18µm της κατασκευάστριας εταιρείας κυκλωµάτων ηµιαγωγών UMC.
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∆ιατηρώντας τις υπόλοιπες παραµέτρους της προσοµοίωσης ενεργοποιούµε τις επιλογές Apply και OK και επανερχόµαστε στο περιβάλλον σχεδίασης. Να επισηµανθεί ότι οποιαδήποτε στιγµή µπορούµε να επαναδιαµορφώσουµε το περιβάλλον προσοµοίωσης µε την εντολή PSpice > Edit Simulation Settings.
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Με καθορισµένες τις παραµέτρους της προσοµοίωσης µπορούµε από το περιβάλλον σχεδίασης να καλέσουµε τον προσοµοιωτή PSPICE. Η κλήση πραγµατοποιείται µε την εντολή PSpice > Run και έχει ως αποτέλεσµα το άνοιγµα του παραθύρου επισκόπησης των αποτελεσµάτων της προσοµοίωσης.
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Στο παράθυρο µπορούµε να διακρίνουµε την γραµµή κύριων εντολών (File, Edit. View, Simulation, Trace, Plot,Tools, Window, Help), από την οποία παρέχεται η δυνατότητα εκτέλεσης όλων των λειτουργιών του εργαλείου. Κάτω από την γραµµή εντολών υπάρχουν κουµπιά συντόµευσης µε τα οποία µπορούµε εύκολα και γρήγορα να εκτελέσουµε µία εντολή. Παρατηρούµε ότι στο κεντρικό τµήµα του παραθύρου κυριαρχεί το σύστηµα των αξόνων όπου θα αποτυπωθούν οι γραφικές απεικονίσεις των κυµατοµορφών των διαφόρων σηµάτων στους κόµβους και τους κλάδους του κυκλώµατος. Καθώς ο τύπος της ανάλυσης που επιλέξαµε νωρίτερα αναφέρεται στο χρονικό πεδίο, ο x-άξονας του συστήµατος φέρει τον κυκλωµατικό χρόνο προσοµοίωσης. Για την αποτύπωση των επιθυµητών κυµατοµορφών επιλέγουµε την εντολή Trace > Add Trace. Στο νέο παράθυρο που ανοίγει και παρουσιάζεται δίδεται µία λίστα µε όλα τα ρεύµατα στους ακροδέκτες των ηλεκτρονικών στοιχείων της σχεδίασης και όλες τις τάσεις στους κόµβους του µε το όνοµα Μεταβλητές Εξόδου (Output Variables).
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Υποστηρίζονται διάφορες µορφές ονοµατολογίας µε αποτέλεσµα το ρεύµα σε έναν ακροδέκτη κάποιου ηλεκτρονικού στοιχείου να περιγράφεται µε περισσότερους του ενός τρόπους. Απενεργοποιώντας την επιλογή Alias Names µπορούµε να αποφύγουµε την παρουσία πολλαπλών ονοµάτων. Επιλέγοντας µε το ποντίκι κάποια µεταβλητή εξόδου παρατηρούµε ότι το όνοµά της προστίθεται στο πεδίο Trace Expression. Μπορούµε να επιλέξουµε ταυτόχρονα περισσότερες της µίας µεταβλητής αλλά καλό θα είναι να µην επιλέγουµε ταυτόχρονα και τάσεις και ρεύµατα παρά µόνο έναν από τους δύο τύπους µεταβλητών. ∆ίδοντας ΟΚ οι κυµατοµορφές όλων των επιλεγµένων µεταβλητών εξόδου απεικονίζονται στο σύστηµα των αξόνων του κύριου παραθύρου του προσοµοιωτή. Στην περίπτωση του έχει επιλεχθεί η µεταβλητή της τάσης V(Output_Signal) για την απεικόνιση της κυµατοµορφής του σήµατος στην έξοδο Output_Signal του κυκλώµατος. Είναι δυνατή η προσθήκη περισσότερων του ενός αξόνων συντεταγµένων µε την εντολή Plot > Add Plot to Window.
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Η προσοµοίωση στο πεδίο του χρόνου µας δίνει την συµπεριφορά του κυκλώµατος παρουσιάζοντας τη χρονική εξέλιξη των τιµών των τάσεων στους κόµβους του και των ρευµάτων στους κλάδους του. Επιλέγοντας στο παράθυρο αρχικοποίησης του PSICE  την Transient ανάλυση, προσδιορίζουµε επιπρόσθετα τον κυκλωµατικό χρόνο της προσοµοίωσης (Run to Time) ο οποίος είναι αναγκαίος για τη µελέτη του κυκλώµατος καθώς και το µέγιστο χρονικό βήµα µε το οποίο θα κινείται ο προσοµοιωτής (Maximum Step Size). Ο κυκλωµατικός χρόνος είναι ο χρόνος για τον οποίο το κύκλωµα λειτουργεί (µε βάση τις τιµές των εισόδων που του παρέχουµε) και για τον οποίο ο προσοµοιωτής µας παρέχει πληροφορία για την συµπεριφορά του κυκλώµατος. Το χρονικό βήµα καθορίζει τις χρονικές στιγµές για τις οποίες ο προσοµοιωτής µας παρέχει αυτή την πληροφορία και προσδιορίζει την ακρίβεια της προσοµοίωσης (µικρότερο βήµα – µεγαλύτερη ακρίβεια). Ο χρόνος που διαρκεί µια προσοµοίωση σε µια µηχανή είναι συνάρτηση του κυκλωµατικού χρόνου προσοµοίωσης και του χρονικού βήµατος, όντας µικρότερος για µικρό κυκλωµατικό χρόνο και µεγάλο βήµα. Στη συνέχεια µετακινούµαστε στο πεδίο των βιβλιοθηκών (Libraries) για να επιλέξουµε το αρχείο µε τις παραµέτρους των ηλεκτρονικών στοιχείων που θα χρησιµοποιήσει ο προσοµοιωτής. Οι βιβλιοθήκες των παραµέτρων των ηλεκτρονικών στοιχείων που χρησιµοποιεί ο προσοµοιωτής δεν σχετίζονται µε τις βιβλιοθήκες των ηλεκτρονικών στοιχείων του σχηµατικού οι οποίες περιέχουν µόνο σύµβολα αυτών των στοιχείων. Με πλοήγηση (Browse) επισηµαίνεται το κατάλληλο αρχείο στο σκληρό δίσκο του συστήµατος και προστίθεται στα αρχεία βιβλιοθηκών της σχεδίασης µε χρήση της επιλογής Add to Design. Τα αρχεία βιβλιοθηκών µιας σχεδίασης µπορούν να είναι περισσότερα του ενός. Αν για κάποιο κυκλωµατικό στοιχείο (π.χ. τρανζίστορ) υπάρχουν περισσότερα του ενός αρχεία βιβλιοθηκών µε παραµέτρους για αυτό το στοιχείο, ενεργές είναι οι παράµετροι του αρχείου που βρίσκεται στην κορυφή της στοίβας. Η επιλογή της τοποθέτησης αυτών των αρχείων στο δίσκο βρίσκεται στην διακριτική ευχέρεια του χρήστη. Για να εκτελεστεί η ανάλυση στο πεδίο του χρόνου θα πρέπει να δοθεί η πληροφορία της χρονικής εξέλιξης των σηµάτων που τροφοδοτούν το υπό προσοµοίωση κύκλωµα, επιτελώντας το ρόλο σηµάτων εισόδου. Για την περιγραφή αυτών των σηµάτων διατίθενται διάφορες πηγές τάσης και ρεύµατος οι οποίες είναι προσβάσιµες µε την εντολή Place > Part και επιλέγοντας στο πεδίο των βιβλιοθηκών (Libraries) τη βιβλιοθήκη Source (εδώ αναφερόµαστε σε βιβλιοθήκες συµβόλων). Οι κυριότεροι τύποι πηγών τάσης και ρεύµατος αναλύονται ακολούθως:
• VDC, IDC: πρόκειται για πηγές τάσης και ρεύµατος αντίστοιχα σταθερής (DC) τιµής. Το µόνο πεδίο που απαιτείται να συµπληρωθεί στις ιδιότητες (επιλογή στοιχείου > δεξί κλικ ποντικιού > Edit properties) σε αυτού του τύπου τις πηγές είναι εκείνο της DC τιµής.

• VEXP, IEXP: πρόκειται για πηγές σήµατος µε εκθετική συµπεριφορά. Στα πεδία των παραµέτρων συµπληρώνονται τα ακόλουθα, α) V1 / Ι1 και V2 / Ι2 η αρχική τιµή του σήµατος και η τιµή σήµατος κορυφής αντίστοιχα (σε volt/ampere), β) TD1 ο αρχικός χρόνος καθυστέρησης εκκίνησης της κυµατοµορφής (σε sec) όπου το σήµα φέρει την προσδιορισθείσα αρχική τιµή (V1/Ι1), γ) TC1 η σταθερά χρόνου µε την οποία ακολούθως µεταβάλλεται εκθετικά η κυµατοµορφή από την αρχική τιµή στην τιµή κορυφής (σε sec), δ) TD2 ο χρόνος που διαρκεί η προηγούµενη µεταβολή (σε sec) και ε) TC2 η σταθερά χρόνου µε την οποία µεταβάλλεται το σήµα από την τιµή κορυφής πίσω στην αρχική τιµή (σε sec).

• VPULSE, IPULSE: είναι πηγές περιοδικού τετραγωνικού.  Τα πεδία που πρέπει να συµπληρωθούν στις ιδιότητες της πηγής είναι, α) PER που προσδιορίζει την περίοδο (σε sec), β) PW που προσδιορίζει το πλάτος του σήµατος (σε sec), γ) TF και TR που είναι οι χρόνοι µετάβασης (καθόδου και ανόδου αντίστοιχα) του σήµατος (σε sec), δ) TD που προσδιορίζει την καθυστέρηση έναρξης του παλµού σε σχέση µε τον χρόνο εκκίνησης της προσοµοίωσης (σε sec) και ε) V1 / Ι1, V2 / Ι2 που είναι η αρχική τιµή του παλµού και η τιµή µετάβασης του παλµού αντίστοιχα (σε volt/ampere).

• VPWL, IPWL: είναι πηγές που περιγράφονται από κυµατοµορφές γραµµικών τµηµάτων (PWL waveform – piecewise linear waveform). Τα πεδία που συµπληρώνονται είναι εκείνα των τιµών σήµατος Vi / Ιi (σε volt/ampere) και των αντίστοιχων χρόνων Ti (σε sec), τόσα όσα απαιτούνται για την περιγραφή της κυµατοµορφής.

• VSIN, ISIN: είναι πηγές ηµιτονικού σήµατος . Τα πεδία ενδιαφέροντος είναι, α) TD που προσδιορίζει την καθυστέρηση έναρξης του σήµατος σε σχέση µε τον χρόνο εκκίνησης της προσοµοίωσης (σε sec), β) VOFF / IOFF η µετατόπιση της τιµής του σηµείου ταλάντωσης ως προς το µηδέν (offset) (σε volt/ampere), γ) VAMPL / IAMPL το πλάτος της ταλάντωσης (σε volt/ampere), δ) FREQ η συχνότητα της ταλάντωσης (σε Hz), ε) PHASE η φάση του σήµατος (σε degree) και στ) DF ο παράγοντας υποβάθµισης του σήµατος στο χρόνο (σε sec-1).
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Κατά την DC ανάλυση σάρωσης ως προς µια µεταβλητή (πηγή σήµατος, παράµετρος, θερµοκρασία), ο προσοµοιωτής υπολογίζει το σηµείο λειτουργίας του κυκλώµατος για κάθε τιµή της µεταβλητής µέσα από ένα προκαθορισµένο πεδίο τιµών σάρωσης και µε βάση ένα προκαθορισµένο βήµα. Το αποτέλεσµα είναι οι τιµές των τάσεων και των ρευµάτων στους κόµβους και τις διακλαδώσεις του κυκλώµατος για κάθε τιµή της µεταβλητής σάρωσης. Για να αρχικοποιήσουµε το PSPISE στην DC ανάλυση σάρωσης επιλέγουµε την εντολή PSpice > New Simulation Profile οπότε εµφανίζεται το παράθυρο για την καταχώρηση της πληροφορίας που αφορά την τρέχουσα διαδικασία προσοµοίωσης.  Ονοματίζουμε την τρέχουσα προσοµοίωση ως DCSweep.
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Στη συνέχεια εµφανίζεται το παράθυρο  για τον προσδιορισµό των παραµέτρων του PSPICE κατά την DC ανάλυση σάρωσης. Επιλέγουµε στον τύπο της ανάλυσης (Analysis Type) την «DC ανάλυση σάρωσης (DC Sweep)». Στο πεδίο των επιλογών (Options) θέτουµε την «πρωτεύουσα σάρωση (Primary Sweep)». Επιλέγουµε ως µεταβλητή σάρωσης, στο πεδίο Sweep Variable, την πηγή τάσης V2 (Voltage Source) που παρέχει το σήµα εισόδου στο κύκλωµα. Στο πεδίο του τύπου της σάρωσης επιλέγουµε αν η σάρωση θα είναι γραµµική (Linear) ή λογαριθµική (Logarithmic. Θέτουµε π.χ. γραµµική σάρωση και επιλέγουµε αρχική τιµή της σάρωσης (Start Value) τα 0V, τελική τιµή (End Value) τα 1.8V και βήµα (Increment) τα 0.2V.
Κατά τον ίδιο τρόπο θα µπορούσε να επιλεγεί ως µεταβλητή σάρωσης µία πηγή ρεύµατος (Current Source), µία γενική παράµετρος (Global Parameter), µία παράµετρος µοντέλου (Model Parameter) όπως το πλάτος W των τρανζίστορ ή τέλος

η θερµοκρασία. Στη συνέχεια µετακινούµαστε στο πεδίο των βιβλιοθηκών (Libraries), όπως είχαµε δείξει νωρίτερα, για να προσδιοριστεί το αρχείο µε τις παραµέτρους των ηλεκτρονικών στοιχείων που θα χρησιµοποιήσει ο προσοµοιωτής. Επιλέγοντας τις βιβλιοθήκες της UMC είµαστε έτοιµοι να εκτελέσουµε την προσοµοίωση. Είναι δυνατή η χρήση δύο µεταβλητών για την πραγµατοποίηση της DC ανάλυσης σάρωσης. Σε αυτή την περίπτωση, στο πεδίο των επιλογών ενεργοποιούµε ταυτόχρονα και την δευτερεύουσα σάρωση (Secondary Sweep). Ο καθορισµός της δεύτερης µεταβλητής και ο προσδιορισµός των παραµέτρων της ανάλυσης δεν διαφέρει από εκείνον για την πρωτεύουσα σάρωση. Το αποτέλεσµα της ανάλυσης είναι ένα σµήνος από καµπύλες που αντιστοιχούν σε διαφορετικές

τιµές της δευτερεύουσας µεταβλητής σάρωσης.
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Η ανάλυση στο πεδίο των συχνοτήτων υπολογίζει τις AC τάσεις στους κόµβους και τα AC ρεύµατα στις διακλαδώσεις ενός κυκλώµατος σαρώνοντας ένα εύρος συχνοτήτων. Τα αποτελέσµατα της ανάλυσης είναι οι τιµές α) του πλάτους και β) των σχετικών φασικών γωνιών των τάσεων και των ρευµάτων ως προς το πεδίο των συχνοτήτων. Με τον όρο ανάλυση στο πεδίο συχνοτήτων εννοούµε “την µικρού σήµατος απόκριση στη συχνότητα”, όπου υποθέτουµε ότι τα σήµατα εισόδου είναι µικρά σήµατα ώστε να ελαχιστοποιούνται τα µη γραµµικά φαινόµενα.

Για τις ανάγκες της προσοµοίωσης προσθέστε στις ιδιότητες της πηγής σήµατος V2 DC=0.9V και AC=0.9V. Η αρχικοποίηση του PSPISE στην ΑC ανάλυση σάρωσης πραγµατοποιείται µε την εντολή PSpice > New Simulation Profile οπότε εµφανίζεται το παράθυρο  για την καταχώρηση της πληροφορίας που αφορά την τρέχουσα διαδικασία προσοµοίωσης. Ονοµατίζουµε την τρέχουσα προσοµοίωση ως ΑCSweep. Στη συνέχεια εµφανίζεται το παράθυρο του, για τον προσδιορισµό των παραµέτρων του PSPICE κατά την ανάλυση, όπου επιλέγουµε στον τύπο της ανάλυσης (Analysis Type) την «ΑC ανάλυση σάρωσης (ΑC Sweep)». Στο πεδίο των επιλογών (Options) ενεργοποιούµε τη «γενική µορφοποίηση (General Settings)». Στο πεδίο του τύπου της AC σάρωσης (AC Sweep Type), µπορούµε να επιλέξουµε γραµµική ή λογαριθµική σάρωση (συνήθως λογαριθµική) καθορίζοντας την αρχική και τελική συχνότητα και τον αριθµό των συνολικών σηµείων ή των σηµείων ανά δεκάδα/οκτάβα αντίστοιχα της προσοµοίωσης. Στην παρούσα φάση δεν επιλέγουµε την ανάλυση θορύβου (Noise Analysis) στο σχετικό πεδίο.
Στη συνέχεια µετακινούµαστε στο πεδίο των βιβλιοθηκών (Libraries),  για να προσδιοριστεί το αρχείο µε τις παραµέτρους των ηλεκτρονικών στοιχείων που θα χρησιµοποιήσει ο προσοµοιωτής. Επιλέγονται οι βιβλιοθήκες της UMC και εκτελείται η προσοµοίωση.
2.2
ΑΝΑΛΥΣΗ ΣΧΕΔΙΑΣΤΙΚΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ OrCAD Layout
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Όταν τελειώσουμε τον σχεδιασμό του κυκλώματος και ελέγξουμε το κύκλωμα ότι λειτουργεί με το simulation μπορούμε να περάσουμε στην διαδικασία για να προετοιμάσουμε το Capture στο Layout.
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Πρέπει να επιλέξουμε από το Project Manager το αρχείο με κατάληξη “./nand.dsn”
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Επιλεγούμε την επιλογή Annotate από την καρτέλα Tools. Το Annotate δημιουργεί ένα  αρχείο με τις ιδιότητες των εξαρτημάτων του σχηματικού.
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Στο επόμενο παράθυρο μπορούμε να επιλέξουμε είτε να δημιουργήσουμε  αρχείο με τις ιδιότητες των εξαρτημάτων στο συγκεκριμένο σχηματικό είτε στα επιλεγμένα εξαρτήματα. 

Μπορούμε να επιλέξουμε τον τύπο των ιδιοτήτων που θέλουμε να δημιουργήσουμε[image: image180.png]— 7ﬂaRC
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Για να ελέγξουμε αν έχουν τηρηθεί όλοι οι κανόνες σχεδίασης κάνουμε κλικ στο Design Rules Check από το Tools menu.
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Ορίζοντας την διαδρομή που θέλουμε να αποθηκεύουμε όπως φαίνεται παρακάτω δημιουργείται ένα αρχείο καταγραφής λαθών  “nand.DRC”.  
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Μπορούμε να αφήσουμε τα προεπιλεγμένα στοιχεία ή μπορούμε να προσαρμόσουμε τα στοιχεία ανάλογα με τις ανάγκες.
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Επιλέγοντας την καρτέλα ERC Matrix μπορούμε να επιλέξουμε τα κριτήρια με τα οποία θα γίνουν οι ηλεκτρικοί έλεγχοι του κυκλώματος. 
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Βλέπουμε αν υπάρχουν λάθη στο κύκλωμα κάνοντας κλικ στο Edit, browse, DRC Markers.
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Πρέπει να δημιουργήσουμε ένα αρχείο Netlist για να μπορέσουμε να μετατρέψουμε το σχηματικό κύκλωμα σε Layout. Το Netlist δεν είναι τίποτα άλλο από ένα αρχείο κειμένου με τον κώδικα των εξαρτημάτων και των συνδέσεων μεταξύ τους που μπορεί το OrCad να αντιληφθεί και αν επεξεργαστεί. Αυτό χρησιμοποιείται και για αναλογικές/ψηφιακές εξομοιώσεις κυκλωμάτων. Η εντολή Create Netlist Βρίσκεται στο Tools menu.
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Το επόμενο βήμα είναι να ενημερώσουμε το αρχείο Annotate με την εντολή Back Annotate. Αυτή η ενημέρωση διότι στο σχηματικό μας έχουν γίνει αλλαγές από όλα τα προηγούμενα βήματα. 
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Με το βήμα αυτό δημιουργείται ένα αρχείο καταλόγου των εξαρτημάτων.
[image: image125.png]tiire

File Design Edit View PSpice_Accessories Reports Options Window _Help
Anratate. = slea@] v

Back Annctate,

Update Properties

Part Manager
Design Rules Check.

=
O Fie |, Hirch  cross Reference.

= 3 Design Resour
nend.d St
—— —
manscf]  COmFle
€ PopiceResoue, 1
Convert LA to DL o
Generate Pt e
]
‘ * e
L
m F
=) ,

create a bil of materds. [essontog 5 | )





[image: image126.png]Billlof Materials

Scope Mode
* Processentiedesign | (+ Uss instances [Preferrec]
Pracess selection Use occurences Cancel
Help

Line ltem Defirition

Header
tem'\Quentiy\FiferencelPar

Combined prapery sing
e\ (Quantty}{Referenceltalue

Flace each patt enty on a separate e

Incluce File

Merge an include fle with report

Repot

Report Fil: | View Dutput
LANANDANAND.BOM Browse.





2.3

ΕΡΓΑΣΤΗΡΙΑΚΕΣ ΑΣΚΗΣΕΙΣ ΣΧΕΔΙΑΣΗΣ
ΑΣΚΗΣΗ 1: Κύκλωμα απλής ανόρθωσης

Να σχεδιάσετε το παρακάτω κύκλωμα απλής ανόρθωσης και να επαληθευτεί η λειτουργία του.
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1. Πραγματοποιείστε transient ανάλυση  για χρόνο 1.6ms και απεικονίστε την είσοδο και έξοδο σε κοινό άξονα. Σχολιάστε το πλάτος της ανορθωμένης τάσης εξόδου ως προς το πλάτος εισόδου.

2. Μεταβάλετε την τιμή της αντίστασης R2 σε 20Kohm και 5Kohm αντίστοιχα. Σχολιάστε και εξηγήστε την κυματομορφή της εξόδου.

3. Αλλάξτε την πηγή της εισόδου σε πηγή ιδανικών τετραγωνικών παλμών ίδιας συχνότητας και πλάτους με την ημιτονική και επαναλάβετε το βήμα ένα. Σχολιάστε τα αποτελέσματα. 
Parts : R/ANALOG, D1N4002/DIODE, VSIN/SOURCE, VDC/SOURCE, 0/SOURCE/GROUND
ΑΣΚΗΣΗ 2: Κύκλωμα διαμόρφωσης AM σήματος
Να σχεδιάσετε το παρακάτω κύκλωμα διαμόρφωσης AM σήματος
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1. Εκτελέστε transient ανάλυση για χρόνο 2msec και απεικονίστε τις εισόδους V3 , V4  και την έξοδο σε κοινό άξονα.

2. Βρείτε το συχνοτικό περιεχόμενο του σήματος εξόδου AM πραγματοποιώντας Fourier ανάλυση.

3. Σχολιάστε τα παραπάνω αποτελέσματα για τη κεντρική συχνότητα και τις αρμονικές.

4. Μεταβάλλετε την συχνότητα της πηγής V4 από 20ΚHz σε 4KHz και 80KHz και επαναλάβετε τα βήματα 1-3.

Parts : R/ANALOG, MULT/ABM, VSIN/SOURCE, 0/SOURCE/GROUND
ΑΣΚΗΣΗ 3: LPF φίλτρο
Να σχεδιάσετε το παρακάτω κύκλωμα  χαμηλοπερατού φίλτρου (LPF)
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1. Πραγματοποιείστε  ac ανάλυση και εμφανίστε το πλάτος και την  φάση της εξόδου output. Βρείτε την συχνότητα αποκοπής θεωρητικά και πειραματικά.

2. Πραγματοποιείστε transient ανάλυση και απεικονίστε την είσοδο και έξοδο σε κοινό άξονα. Σχολιάστε το αποτέλεσμα με βάση και το προηγούμενο βήμα.

3. Εκτελέστε transient ανάλυση στις θερμοκρασίες 0 27 και 800 C. Ποια τα συμπεράσματά σας.

4. Μεταβάλλετε την συχνότητα της πηγής από 8ΜΗz σε 40 ΜΗz και 800 ΜΗz και επαναλάβετε τα παραπάνω δύο βήματα. Σχολιάστε.

5. Στο αρχικό σχήμα με την πηγή στα 8 ΜΗz αλλάξτε την τιμή της αντίστασης από 10Ω σε 10 ΚΩ. Τι παρατηρείτε στην έξοδο;  

6. Που μπορεί να χρησιμοποιηθεί το παραπάνω κύκλωμα: Αναφέρετε τυχόν άλλα είδη και τη λειτουργία τους.
Parts : R/ANALOG, VSIN/SOURCE, C/ANALOG, 0/SOURCE/GROUND
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Σχέσεις απόκρισης φίλτρου : 
[image: image129.wmf]
ΑΣΚΗΣΗ 4: Current mirror
Να σχεδιάσετε το παρακάτω κύκλωμα καθρέπτη ρεύματος σε τεχνολογία  CMOS 0.18u
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1. Η μαθηματική σχέση που διέπει την λειτουργία του καθρέπτη ρεύματος είναι: [image: image131.png]



2. Ρυθμίστε κατάλληλα τα τρανζίστορ με βάση την προηγουμένη μαθηματική σχέση  ώστε το ρεύμα εξόδου να είναι 20πλάσιο  του ρεύματος αναφοράς (αγνοήστε τη διαμόρφωση μήκους καναλιού λ και L1=L2).
3. Εκτελέστε transient ανάλυση και δείτε το αποτέλεσμα της θεωρητικής σας σχεδίασης. Τι παρατηρείτε; Πού οφείλεται τυχόν απόκλιση;
4. Ρυθμίστε κατάλληλα το κύκλωμα ώστε να έχω ρεύμα εξόδου α) 20mA           β) 5 mA. Να δείξετε το ρεύμα εξόδου χρησιμοποιώντας την επιλογή Bias current display.  

5. Εκτελέστε transient ανάλυση στις θερμοκρασίες 0 27 και 800 C. Ποια τα συμπεράσματά σας. 
6. Αναφέρετε χρήσεις του καθρέπτη ρεύματος στην ηλεκτρονική. 
Parts : R/ANALOG, VDC/SOURCE, MbreakN4D/BREAKOUT, 0/SOURCE/GROUND

ΑΣΚΗΣΗ 5: Differential Amplifier
Να σχεδιάσετε το παρακάτω κύκλωμα διαφορικού ενισχυτή σε τεχνολογία  CMOS 5u
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1. Εκτελέστε DC ανάλυση μεταβάλλοντας την πηγή V2 από 0 μέχρι 5 V με βήμα 0.1. Βρείτε το σημείο λειτουργίας του κυκλώματος και εξηγήστε τι εκφράζει.

2. Εκτελέστε transient ανάλυση και απεικονίστε διαφορικά την έξοδο κοινού τρόπου (τα άκρα drain των τρανζίστορ Μ1,Μ2). Τι παρατηρείτε; Υπολογίστε την ενίσχυση κοινού τρόπου ACM.
3. Απεικονίστε, εκτελώντας  transient ανάλυση 400us, την έξοδο διαφορικού σήματος. Υπολογίστε περίπου την ενίσχυση του διαφορικού ενισχυτή ADM.

4. Υπολογίστε τον  λόγο απόρριψης κοινού τρόπου CMRR; 

5. Αλλάξτε την τιμή των αντιστάσεων R3, R2 στα 100ΚΩ. Τι επίδραση έχει η αλλαγή αυτή στην ενίσχυση διαφορικού σήματος;

6. Αλλάξτε την τιμή της αντίστασης R1 σε 40ΚΩ. Τι επίδραση έχει η αλλαγή αυτή στην ενίσχυση διαφορικού σήματος;
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Μαθηματικές σχέσεις

διαφορικού ενισχυτή:   

Parts : R/ANALOG, C/ANALOG, VSIN/SOURCE, VDC/SOURCE, MbreakN4D/BREAKOUT, 0/SOURCE/GROUND

ΑΣΚΗΣΗ 6: Λογική πύλη NAND
Να σχεδιάσετε το παρακάτω κύκλωμα πύλης NAND δυο εισόδων.
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1. Πραγματοποιείστε transient ανάλυση  για χρόνο 4ns και απεικονίστε τις εισόδους Α, Β και έξοδο out σε κοινό άξονα.
2. Εκτελέστε transient ανάλυση στις θερμοκρασίες 0 27 και 1000 C. Ποια τα συμπεράσματά σας.
Parts : MbreakP-ND/BREAKOUT, VPULSE/SOURCE, VDC/SOURCE, 0/SOURCE/GROUND
Σημ.: Απαιτείται να εισάγετε την αντίστοιχη library UMC 0.18u TT.
Πίνακας αληθείας της πύλης NAND:
	A
	B
	OUT

	0
	0
	1

	0
	1
	1

	1
	0
	1

	1
	1
	0


ΑΣΚΗΣΗ 7: Κύκλωμα Αστέρα
Να σχεδιάσετε το παρακάτω κύκλωμα τριφασικού κυκλώματος σε συνδεσμολογία αστέρα.
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1. Πραγματοποιείστε transient ανάλυση  για χρόνο 40ms και απεικονίστε τα ρεύματα που διαρρέουν τα φορτία R7, R8, R9 σε κοινό άξονα. Σχολιάστε τα αποτελέσματα.

2. Απεικονίστε την ισχύ P που καταναλώνουν οι αντιστάσεις. (Η ισχύς δίνεται από τον τύπο P=I*V)
Parts : R/ANALOG, VSIN/SOURCE, 0/SOURCE/GROUND

Σημ.: α) V είναι η τάση στα άκρα της αντίστασης R, β) η ισχύς που καταναλώνεται σε μια αντίσταση δεν μπορεί να είναι αρνητική.
ΑΣΚΗΣΗ 8: Κύκλωμα τριγώνου
Να σχεδιάσετε το παρακάτω κύκλωμα τριφασικού κυκλώματος σε συνδεσμολογία τριγώνου.
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1. Πραγματοποιείστε transient ανάλυση  για χρόνο 40ms και απεικονίστε τα ρεύματα που διαρρέουν τα φορτία R1, R2, R3 σε κοινό άξονα. Σχολιάστε τα αποτελέσματα.

2. Απεικονίστε την ισχύ P που καταναλώνουν οι αντιστάσεις. (Η ισχύς δίνεται από τον τύπο P=I*V)
Parts : R/ANALOG, VSIN/SOURCE, 0/SOURCE/GROUND

Σημ.: α) V είναι η τάση στα άκρα της αντίστασης R, β) η ισχύς που καταναλώνεται σε μια αντίσταση δεν μπορεί να είναι αρνητική.
ΑΣΚΗΣΗ 9: RLC κύκλωμα
Να σχεδιάσετε το παρακάτω κύκλωμα  RLC
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1. Εκτελέστε transient ανάλυση για χρόνο 1sec με start saving data 0.9sec και step size 1msec απεικονίζοντας την είσοδο V8  και την έξοδο σε κοινό άξονα. Κάντε FFT και σχολιάστε το αποτέλεσμα.

2. Πραγματοποιείστε  ac ανάλυση με αρχική συχνότητα 1Hz, τελική 100MHz σε λογαριθμική κλίμακα με points/decade 500. Υπολογίστε τη συχνότητα συντονισμού fn=1/2π(LC)½ και το συντελεστή ποιότητας Q=(1/R)*(L/C) ½ θεωρητικά και πρακτικά. Αλλάξτε την τιμή της αντίστασης R σε 100Ω. Τι επηρεάζεται κατά την γνώμη σας;

3. Με κατάλληλη επιλογή marker απεικονίστε το πλάτος και την φάση σε dB (διαγράμματα bode) της εξόδου.

Parts : R/ANALOG, C/ANALOG, VSIN/SOURCE, 0/SOURCE/GROUND, L/ANALOG
ΑΣΚΗΣΗ 10: Differential RF CMOS mixer
Να σχεδιάσετε το παρακάτω κύκλωμα μίκτη σε τεχνολογία  CMOS 0.18u. Τα σήματα RF και LO εισάγονται διαφορικά. Η έξοδος IF λαμβάνεται διαφορικά. 
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1. Εξηγήστε την λειτουργία του μίκτη. Αναφέρετε που χρησιμοποιείται.

2. Εκτελέστε transient ανάλυση και απεικονίστε τέσσερις περιόδους του σήματος εξόδου. Κάντε FFT και σχολιάστε το γράφημα.

3. Προτείνετε τρόπο αντικατάστασης της ιδανικής πηγής ρεύματος με αντίστοιχο ηλεκτρονικό κύκλωμα.

4. Προσθέστε στην έξοδο πυκνωτή C=400fF. Απεικονίστε την έξοδο IF στο χρόνο και στη συχνότητα. Τι παρατηρείτε;   

5. Εκτελέστε transient ανάλυση στις θερμοκρασίες 0 27 και 800 C. Ποια τα συμπεράσματά σας.

Parts: MbreakN4D/BREAKOUT, VSIN/SOURCE, VDC/SOURCE, R/ANALOG, IDC/SOURCE, 0/SOURCE/GROUND
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